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Conventions used in the documentation 

 

Convention Meaning  

Bold Used for all elements displayed in the Alfabet interface including, for example, menu 
items, tabs, buttons, dialog boxes, page view names, and commands.  

Example: Click Finish when setup is completed. 

Italics Used for emphasis, titles of chapters and manuals. 

this 

Example: see the Administration reference manual.  

Initial Capitals Used for attribute or property values.  

Example: The object state Active describes...  

All Capitals Keyboard keys 

Example: CTRL+SHIFT  

File >  
Open 

Used for menu actions that are to be performed by the user. 

Example: To exit an application, select File >  Exit 

< > Variable user input 

Example: Create a new user and enter <User Name>. (Replace < > with variable data.) 

 
This is a note providing additional information. 

 
This is a note providing procedural information. 

 
This is a note providing an example. 

 
This is a note providing warning information. 



  

Alfabet 10.15 ©2022 Software AG. All rights reserved. Reference Manual 4 

Table of Contents 

 

Chapter 1: Introduction to IT Planning Basic 5 

Chapter 2: Lifecycle Management 7 
Methodology: Application Lifecycle Management 8 
Prerequisite: Configuring Lifecycles 10 
Managing IT Lifecycles in the Application Architecture 10 

Chapter 3: Business Model Definition 13 
Methodology: Defining Operational Aspects of the Business Model 13 
Prerequisite: Configuring Operational Aspect Classes 14 
Specifying and Analyzing Operational Aspects in the Enterprise 15 

Chapter 4: Business IT Synchronization 18 
Documenting the Enterprise's Policies 19 

Understanding Governance and Responsibility for Policies 19 
Capturing the Enterprise's Policies 20 
Associating Policies with the Enterprise's Strategic Intentions 20 
Prerequisites: Configuration Required for Policy Definition 21 

Designing the Enterprise's IT Strategy 21 
Methodology: Conceptualizing the IT Support for the Target Architecture 22 
Methodology: Understanding Strategic Business Supports 23 
Methodology: Conceptualizing Non-IT Support for the Target Architecture 25 
Methodology: Using Blueprints to Plan the To-Be and Target Architectures 27 
Understanding Governance and Responsibilities for IT Strategies 29 
Specifying an IT Strategy for the Target Architecture 29 
Planning the Strategic Business Support in a Business Support Map 31 
Analyzing the Strategic Business Support and IT Strategy 33 
Associating an IT Strategy with the Enterprise's Strategic Intentions 35 
Prerequisites: Configuration Required for Strategy Planning 35 

Chapter 5: Target Architecture Design 36 
Methodology: Conceptualizing a Roadmap for the To-Be Architecture 36 
Methodology: Understanding Tactical Business Supports 39 
Methodology: Implementing Solution Building Blocks as Planning Objects 43 
Specifying a Master Plan for the To-Be Architecture 44 
Planning the Tactical Business Support in a Business Support Map 45 
Analyzing the Master Plan 48 
Prerequisites: Configuration Required for Master Planning 51 

Appendix 1: Working with Business Support Maps 52 
Quick Start Tips for the Business Support Map 54 
Setting Up the X- and Y-Axes of the Business Support Map 56 
Implementing Business Process Model Filters in Business Support Maps 58 
Communicating about Business Supports via the Notepad Functionality 58 
Highlighting Matrix Objects With Color 59 

 

 



 
 Chapter 1: Introduction to IT Planning Basic 

Alfabet 10.15 ©2022 Software AG. All rights reserved. Reference Manual 5 

Chapter 1:  Introduction to IT Planning Basic 

The IT Planning Basic sales package allows you to collaborate with business to transform the business 
model and operating model. This sales package enables you to manage the lifecycle of the IT infrastructure, 
thus providing relevant information about the end-of-life of the enterprise's applications and components 
necessary for planning the target architecture. 

By means of the Business Model Definition capability, you can capture the various dimensions of the busi-
ness model of the enterprise including its market products, sales channels, customer segments, markets 
and brands in order to understand how these operational aspects are supported by the IT. Furthermore, the 
IT Planning Basic sales package allows you to understand the enterprise's current operational support and 
conceptualize and prepare for the enterprise's medium-term and long-term IT. For an organization with a 
high level of maturity, the enterprise's policies and long-term strategies can be articulated to serve as the 
keystone in translating business strategy to strategic and tactical IT planning and moving the as-is IT land-
scape to a long-term target landscape. 

A first step to qualify the value of IT with minor effort is to understand an application's operational business 
supports. A simple assignment of applications to the supported business processes reveals first high-level 
information about redundancies and gaps in the IT infrastructure. Later, simple impact analysis can be exe-
cuted in order to ultimately plan a strategic migration from the as-is architecture to the long-term target 
architecture. 

The Business IT Synchronization capability allows you to document your company's long-term strategic 
business support in the context of an IT strategy. With a clearly articulated IT strategy in place, strategic 
migration plans can be defined to migrate the business support and medium-term master plans can be 
specified to capture the roll-out of tactical business supports. 

With the Target Architecture Definition capability, you can specify a master plan to roadmap the medium-
term tactical business supports. Alfabet’s patented master planning functionality is a keystone in translat-
ing the business strategy into IT tactics. Well-defined IT strategies show the use of applications in support 
of business operation and provide IT organization with a clear overview of the relevant aspects of the IT 
landscape in order to understand how strategic decisions will and should impact the IT's tactics and direc-
tion over time. IT strategy planners can explore tactical options for rolling-out applications, ensure that 
flexibility in the IT architecture is accommodated, and confirm that IT planning are in alignment with the 
business' strategic vision. 
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The IT Planning Basic sales package is used by IT and business strategists, planners and project managers 
as well as general leadership functions across business and IT to: 

• manage the lifecycle of the architecture elements in the IT infrastructure 

• understand the IT support for various aspects of the business model 

• capture the enterprise's policies in order to articulate the guidelines for business 

• define the company’s IT strategies in terms of business support for the long-term target 
architecture 

• design medium-term architectural scenarios via master plans and create architectural roadmaps 

• create blueprints to standardize IT solutions across the enterprise 

• plan and manage migrations in accordance with the IT strategies and master plans they are 
associated with 

By implementing a disciplined planning strategy, you can support the enterprise in its goals towards stand-
ardization and simplification. Reusing the same applications for the same business process results in fewer 
applications, less complexity and risk, and reduced costs and maintenance efforts. 

The following information is available: 

• Introduction to IT Planning Basic 

• Lifecycle Management 

• Business Model Definition 

• Business IT Synchronization 

• Target Architecture Design 

• Appendix:Working with Business Support Maps 
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Chapter 2:  Lifecycle Management 

Lifecycle management is an integral part of roadmapping and necessary to establish plans to transition the 
operational model to a target architecture. Lifecycle management includes the process of identifying and 
managing conflicts in the lifecycles of objects in the IT architecture such as applications and components. 
Understanding the lifecycle of applications and other architecture elements in the IT infrastructure allows 
the enterprise to identify, for example, when new applications and components need to be introduced to 
support the enterprise's business processes in alignment with its strategies and vision. For a complete 
overview of the object classes that support lifecycle definition, see the chapter Overview of Configurable 
Features for Object Classes in the reference manual Configuring Alfabet with Alfabet Expand - Appendix. 

Documenting and maintaining the lifecycles of ICT objects, applications, and business supports in the as-is 
landscape is necessary in order to design relevant architectural scenarios to design the master plans that 
serve as the medium-term roadmap to realize the enterprise's long-term IT strategies. A disciplined lifecy-
cle management program ensures that migration plans can be defined and rolled-out to support master 
planning efforts. 

A lifecycle describes the succession of stages that an architecture element goes through. Many objects 
(for example, applications, components, standard platforms, business supports) in Alfabet have a lifecycle, 
although a lifecycle does not have to be defined for all objects. A lifecycle is comprised of lifecycle phases 
that describe the object's status of activity or production over time. Each lifecycle phase is aligned with its 
proceeding and succeeding lifecycle phase. 

The lifecycle definition also includes the definition of the object’s active period. The active period of an ob-
ject is considered the period that the object is in production. Therefore, the active period of an object cor-
responds to the object’s start and end dates. The active period may be configured to be aligned with one or 
more specified lifecycle phases that represent the period when the object is in production. Typically, the 
object state of the object will be specified as Active in the period between the start and end date. 

The lifecycle definitions of dependent objects should be aligned with the lifecycle of the object that they 
have been defined for. For example, the lifecycles of any local components, information flows, and business 
supports should be aligned with the lifecycle of the application that they are assigned to. In the case of 
components, the lifecycles of any local components, information flows, and technical services should be 
aligned with the component’s lifecycle. 

Furthermore, the lifecycle definition for an application may include the specification of predecessor and 
successor versions and the lifecycle definition of components may have successor versions. Successor 
versions will be assigned per default to the same ICT object as the original application/component, but this 
can be modified, as needed. 

The following information is available: 

• Methodology: Application Lifecycle Management 

• Prerequisite: Configuring Lifecycles 

• Managing IT Lifecycles in the Application Architecture 

 
Please note a context-sensitive Help is available for each view available in the context of lifecycle 
management. You should refer to the Help if you require an explanation about the functionalities 
and information available in a specific view. 
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Methodology: Application Lifecycle Management 

Application lifecycle management includes the process of identifying and managing conflicts in the lifecy-
cles of an application and its application versions and variants in order to ensure the availability and reliabil-
ity of applications in the enterprise. Each application must have an object state defined as well as a start 
and end date. The object state specifies the operational status of the application in the enterprise. 

  

 FIGURE: Application object state 

The lifecycle definition includes the specification of the object’s active period, which corresponds to the 
object's start and end dates. When the object is first created, the object state will be set to Active in align-
ment with the object's start and end dates. Even if the object state is later changed, the active period of the 
lifecycle will correspond to the start and end dates of the object. 

  

 FIGURE: Application lifecycle 

The application lifecycle describes the succession of stages that the application goes through. The lifecycle 
is comprised of lifecycle phases that describe the application's status of activity or production. In the figure 
above, an application lifecycle consists of the lifecycle phases Pilot, Production, Limited Production, and 
Retired, and the lifecycle phase Production represents the active period of the application. The definition of 
a start and end date is mandatory when an application is created, but the lifecycle phases must be explic-
itly defined for each application. 

An aspect of application lifecycle management is versioning applications and managing the application 
versions. Versioning applications describes the transition of one version of an application to the next from 
the enterprise architecture point of view. Every application that you define is actually an application ver-
sion with its own defined lifecycle. An application may have predecessor and successor versions, thus 
providing information about the migration plans for the application as well as the evolution of a specific 
type of business support or business service. 
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When an application is versioned, the new application version will become the successor version when the 
base application reaches its end date. The new application version's start date will be automatically defined 
to begin one day after the base application's end date and the new application version's end date will be 
defined to begin 5 years after its start date. These dates may be edited as needed. 

  

 FIGURE: Versioned applications assigned to ICT object 

The application version will be assigned automatically to the same ICT object that owns the application that 
it is versioned from. Applications are typically assigned to an ICT object in order to manage application 
budgets and plan the IT architecture. An ICT object (ICT = Information and Communication Technology) is 
an abstract object that represents applications regardless of their versioning and is a means to plan and 
control costs related to the application and its infrastructure. The use of ICT objects is advantageous in 
that the planner must not initially commit him/herself to a certain version of the application. By means of 
the ICT object, portfolio managers can understand the operating costs of the application. Later, at the 
stage of detailed strategic planning of the target architecture, the ICT object can be used to plan business 
supports. In the stages of master planning where an IT roadmap is being established, the ICT object can be 
replaced by a specific concrete application version. 
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In order to describe the operational support that the application provides to the many business processes 
in the organization, multiple business supports can be created for the application. The start and end dates 
of the operational business support must be aligned with the application that is the provider of the support. 
In other words, the start date of a business support may not be before the start date of the providing appli-
cation and the end date may not be after the end date of the application. 

Prerequisite: Configuring Lifecycles 

In order to define the lifecycle of any object in Alfabet, the XML object ObjectLifeCycleManager must be 
configured for the relevant object classes by your solution designer in the configuration tool Alfabet Ex-
pand. A lifecycle definition consisting of lifecycle phases can be configured for object classes that support 
the lifecycle concept. For a complete overview of the object classes that support lifecycle definition, see 
the chapter Overview of Configurable Features for Object Classes in the reference manual Configuring 
Alfabet with Alfabet Expand - Appendix. 

 
Please note that lifecycle definitions cannot be configured for individual object class stereotypes. 
The object class stereotype will inherit the lifecycle concept of the object class that it is based 
on. 

The solution designer will configure the number of the lifecycle phases that make up the lifecycle definition 
of a specific object class as well as specify the name and default duration of each lifecycle phase. The solu-
tion designer will specify which lifecycle phases shall be mapped to the active period of an object class. 
When an object is created, the object state will be set to Active per default and the active period of the ob-
ject will be the period starting with the start date and ending with the end date. For example, the solution 
designer may configure the active period to represent the lifecycles status Pilot, Production, and Limited 
Production but not the lifecycle phases Evaluation and Shut Down. When a user defines an object's lifecy-
cle phases in the Lifecycle editor, the lifecycle phases specified for the active period will automatically be 
aligned with the object's start and end dates. The actual duration of a lifecycle phase defined for an object 
may be manually edited in the Lifecycle editor available in the Lifecycle Page View by a user with relevant 
access permissions 

For more information about configuring lifecycle definitions, see the section Configuring Lifecycle Defini-
tions for Object Classes in the reference manual Configuring Alfabet with Alfabet Expand. 

Managing IT Lifecycles in the Application Architecture 

The Lifecycle Page View page view displays a Gantt chart showing the lifecycle of a selected application, 
the lifecycles of its predecessor and successor versions, as well as the lifecycle of the ICT object that owns 
the application. Please note the following: 

• The maximum period of time displayed for lifecycles in the Lifecycle Page View is limited to 40 
years. The time displayed will be based on 20 years before the current date and 20 years after the 
current date. 

• When an application is initially created, the start and end dates constitute the active period of the 
application's lifecycle. However, the various lifecycle phases that constitute the lifecycle must be 
explicitly defined in the Lifecycle Page View. The lifecycle phases can be added to the ICT object or 
application lifecycle in the Lifecycle editor. Please note the following:  
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• Select the ICT object or application in the Gantt chart that you want to specify and click the 
Edit Lifecycle button to open the Lifecycle editor. 

• Set a checkmark for each lifecycle that you want to include in the application lifecycle. You 
should not set a checkmark for a lifecycle phase that you want to leave out of the selected 
object’s lifecycle definition. The duration of the lifecycle phase will be determined by the 
default duration configured by your solution designer. 

• To change the duration of the lifecycle phase, select a lifecycle phase (colored bar) in the time 
bar and click the handle for the start or end date. Drag the handle to define the relevant date. 
If you select the Keep Phases Duration checkbox, the adjacent lifecycle phase will retain its 
current time span. If you do not select the Keep Phases Duration checkbox, the lifecycle 
phase adjacent to the phase you are editing will increase or decrease proportionally. 

• Each lifecycle phase must have a minimum duration of 1 day. If the phase is less than 1 day, it 
should be skipped. 

• If you edit an application’s start date and end dates or shift the active period in the Lifecycle 
editor, the lifecycle definition of any local components, information flows, or business supports 
associated with the application will not be automatically changed. To align the start and end dates 
of a selected application's dependent objects, you must use the Shift Start/End Dates 
functionality available in the object profile of the relevant application. 

• In addition to defining lifecycles of the ICT objects and applications displayed in the Lifecycle Page 
View, you can also version the applications via the Create New Version functionality. Please note 
the following regarding application versioning:  

• The new application version will automatically be based on the same object class stereotypes 
as the base application. 

• The start date of the application version will be automatically defined to begin one day after 
the base application's end date. The end date will be automatically defined to begin 5 years 
after the start date. These dates may be edited as needed. 

• The base application's lifecycle phases will be copied to the new application version and will 
not be adjusted to the new start and end dates of the application version. Therefore, they 
must be explicitly redefined in the Lifecycle Page View. 

• In addition to the base application's standard and custom attributes, the following attributes 
will be copied from the base application to the new application version:  

• Business Service 

• Business Support 

• Business Data 

• Domain 

• ICT Object 

• Information Flow 

• Lifecycle 

• Local Component 

• Platform 

• Indicators 

• The Standard Application Diagram Page View designed for the base application will be copied 
to the new application version. The application version will replace the base application in the 
copied diagram and the application version will be visualized as the source or target of the 
copied information flows. Please note however that these information flows will not inherit the 
design of the base information flows. The layout, color, and decoration boxes must be newly 
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designed for the successor information flows. For more information about designing 
information flows in application diagrams, see the reference manual Designing IT Landscape 
Diagrams in Alfabet. 

The Provided Business Support Page View allows operational business supports to be defined and man-
aged for a selected application. The start date of the operational business support may not be before the 
start date and the end date may not be after the end date of the application providing the business sup-
port. If the dates of operational business supports are not within the start and end dates of the providing 
application, they will be highlighted red. The dates of all misaligned business supports can be adjusted via 
the Action > Align to Start/End Date of Application functionality. 
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Chapter 3:  Business Model Definition 

The Business Model Definition capability supports the definition of the various dimensions of the enter-
prise's business model to gain a clear understanding of the necessary resources and IT support. This capa-
bility allows you to identify key architecture areas and resources necessary to support the operational as-
pects of the business model including its market products, sales channels, customer segments, markets, 
and brands. Documenting the relevant operational aspects of the business model enables you to analyze 
and compare the enterprise's product offering and exposes the business areas generating value for the 
company. 

The following information is available: 

• Methodology: Defining Operational Aspects of the Business Model 

• Prerequisite: Configuring Operational Aspect Classes 

• Specifying and Analyzing Operational Aspects in the Enterprise 

 
Please note a context-sensitive Help is available for each view available in the Business Model 
Definition capability. You should refer to the Help if you require an explanation about the func-
tionalities and information available in a specific view. 

Methodology: Defining Operational Aspects of the Business Model 

An operational aspect is a facet of the business that may be supported by the IT. In Alfabet, the classes 
Brand, Customer Segment, Market, and Sales Channel are standard object classes that represent typical 
operational aspects. However, other object classes or object class stereotypes may be configured by your 
solution designer as operational aspects. Multiple operational aspects can be created for each relevant ob-
ject class to express the individuals facets of business that require support. 
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For the class Market, for example, the operational aspects Capital Markets, Retail Banking, Emerging Mar-
kets, and Direct Banking could be specified. Or for the class Sales Channel, the operational aspects Finan-
cial Advisory, Banking Center, and Mobile & Online could be defined. 

  

In the context of planning business support in the enterprise, the IT architect or IT planner can associate 
the business' operational aspects with the organizations or business processes that contribute to them. In 
the example above, the operational aspects Capital Markets, Retail Banking, Emerging Markets, and Direct 
Banking are assigned to the business process Asset Class Trading and the operational aspects Financial 
Advisory, Banking Center, and Mobile & Online are assigned to the organization WP Investment. The opera-
tional business support provided by the application TradeNet may support any or all of the operational as-
pects. The specification of the operational aspects that a business support contributes to ensures an un-
derstanding of how individual operational business supports are instrumental to operational aspects of the 
business and sheds light on where future support via tactical business supports and strategic business 
supports is required in order to realize the enterprise's long-term IT strategy. 

 

Some enterprises may specify market products on the X-dimension and domains on the Y-di-
mension. For the sake of simplicity, this documentation will refer to X-dimension objects as 
business processes and Y-dimension objects as organizations. 

Prerequisite: Configuring Operational Aspect Classes 

 

The following information describes the configuration required to implement operational aspects 
in Alfabet. The conceptualization of operational aspects is dependent on the business support 
concept that you will implement in your enterprise. In particular, your enterprise will need to 
configure the object classes on the X-dimension and Y-dimension of the business support. This 
is explained in more detail in the section Setting Up the X- and Y-Axes of the Business Support 
Map. 

The following configuration is required in order to implement operational aspects: 
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• Several attributes in the XML object ITMapDef must be configured. The XML element 
AspectClasses must specify the object classes (Brand, CustomerSegment, Market, and 
SalesChannel) that can be defined as operational aspects for the object classes on the matrix 
axes as well as for operational business supports, tactical business supports, strategic business 
supports, and solution business supports. Other object classes or object class stereotypes may 
also be specified. Please note that the object class property ShortName is required in order to 
visualize the operational aspects in a very small attributes box in cells in business support 
matrices. Please note that the short name should consist of only 2 or 3 letters. For additional 
details about configuring operational aspect classes in the context of business support planning, 
see the section Configuring Standard Business Support Matrices in the reference manual 
Configuring Alfabet with Alfabet Expand. 

• If object class stereotypes shall be specified in the XML element AspectClasses, these must be 
configured. Please note that the object class property ShortName must be available for the object 
class stereotype. For more information about configuring object class stereotypes, see the section 
Configuring Object Class Stereotypes for Object Classes in the reference manual Configuring 
Alfabet with Alfabet Expand. 

• Depending on the object classes that may be specified as operational aspects, the following 
functionalities must be available to the relevant user profiles for which creating operational 
aspects shall be permissible:  

• Capture Brands Functionality 

• Capture Customer Segments Functionality 

• Capture Markets Functionality 

• Capture Sales Channels Functionality 

Specifying and Analyzing Operational Aspects in the Enterprise 

Potential gaps or redundancy in the support of operational aspects can be understood and analyzed in the 
context of business support maps that depict the as-is architecture, the medium-term to-be architecture, 
and the long-term target architecture: 

• Create Operational Aspects: Operational aspects must first be created before they can be made 
available for business support planning: Please note the Short Name attribute must be defined for 
each the brand, customer segment, etc. The short name will be displayed in a very small attributes 
box on the business supports in business support maps. Therefore, the short name should consist 
of only 2 or 3 letters. Operational aspects must be created in the following views, depending on the 
object classes that may be specified as operational aspects.  

• Capture Brands Functionality 

• Capture Customer Segments Functionality 

• Capture Markets Functionality 

• Capture Sales Channels Functionality 

• Assign Operational Aspects to Business Processes and Organizations: Once the operational 
aspects (brands, custom segments, markets, etc.) have been created, they can be assigned to the 
relevant object classes that represent the X- and Y-dimensions of a business support. These are 
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typically business processes (X-dimension) and organizations (Y-dimension). This is done in the 
Operational Aspects Page View available in the object profile of the respective object. 

• Specify Operational Aspects for Operational Business Supports: In the context of creating 
operational business supports for the as-is architecture, you can specify which operational 
aspects shall be supported by which business supports. When an operational business support is 
created, all operational aspects assigned to the business process or organization (or domain or 
market product) supported by the business support will be displayed in the Aspects tab of the 
Operational Business Support editor. A checkmark should be set for each operational aspect that 
the business support provides support to. The Operational Business Support editor is available in 
all views where operational business supports can be created including, for example, the Business 
Support Page View for business processes, organizations, domains, market products, and 
applications as well as the Business Support Map Page View available for a master plan map or IT 
strategy plan. 

• Analyze the Business Supports Contributing to an Operational Aspect: It is also possible to 
understand all business supports that contribute to an operational aspect. The Business Support 
Map Report (As Aspect) Page View available in the object profile of the selected operational aspect 
(for example, the object profile of the brand, customer segment, etc.) displays all operational, 
tactical, and strategic business supports that contribute to the operational aspect as well as the 
supported business processes on the X-axis and the supported organizations on the Y-axis. The 
following analyses are useful to understand the business support:  

• To display the operational aspects on the business support, select View Options > Show 
Attributes checkbox. The attributes box is overlaid on the business supports in the matrix 
and displays the object state in the first row and the operational aspects in the second and 
third rows. This view helps you to understand how business supports with the same provider 
may differ in terms of the operational aspects that they support. 

• To understand whether a business support consistently contributes to a set of operational 
aspects across multiple business processes, select View Options > Join Items checkbox. Only 
adjacent business supports with a common set of operational aspects will be joined on the X-
axis. 

• Analyze the Alignment of Operational Aspects for a Business Support Provider: Typically an 
application will be the provider of business support, although it is also possible that an organization 
may be the business support provider. A Business Support Map Report Page View is available in 
the object profile of the business support provider and displays all business processes and 
organizations that the provider supports. The X-axis displays the business processes supported by 
the provider and the Y-axis will display the organizations supported by the provider. Additionally, 
any other business supports supporting any of the business processes on the X-axis or 
organizations on the Y-axis will be displayed. These additional business supports can be hidden 
from view by showing only the business supports provided by the selected base object. Similar to 
the Business Support Map Report (As Aspect) Page View described above, you can also select the 
Join Items checkbox to display whether business supports consistently contributes to a set of 
operational aspects across multiple business processes. 

• In the context of the IT strategy planning and master planning, the analysis of operational aspects 
can be relevant when planning the long-term target architecture as well as the medium-term to-
be architecture. This is described in more detail in the sections Business IT Synchronization and 
Target Architecture Design respectively. The following can be carried out:  

• Specify Operational Aspects for Tactical and Strategic Business Supports: Similar to the 
definition operational aspects for operational business supports, operational aspects can be 
explicitly defined for a tactical or strategic business support when it is created in the Tactical 
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Business Support Page View or Strategic Business Support Page View or in the Business 
Support Map Page View available for a master plan map or IT strategy plan. It is also possible 
to create a tactical business support or strategic business support based on an existing 
operational business support. In this case, the operational aspect definition will be copied and 
can be modified if needed. 

• Analyze the Alignment of Operational Aspects in an IT Strategy: At the stage of defining 
the target architecture and master planning, you can define strategic business supports for a 
specific IT strategy as well as define the tactical business supports for the master plans that 
serve as the roadmap to the target architecture. Additionally, you can analyze how the tactical 
and strategic business supports contribute to the operational aspects relevant for business 
processes and organizations. The specification and analysis of a target architecture in 
alignment with the enterprise's IT strategy and master plans for the medium-term to-be 
architecture is complex and thus described in detail in the sections Business IT 
Synchronization and Target Architecture Design. 
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Chapter 4:  Business IT Synchronization 

Alfabet provides a Business IT Synchronization capability that supports the synchronization of the busi-
ness and the IT in order to help decision-makers make better IT investment decisions and reduce transfor-
mational risks. IT structures can be aligned with business objectives and processes in order to ensure that 
IT transformation goes hand-in-hand with business transformation. 

In order to articulate the enterprise's guidelines that should be followed to ensure that business is con-
ducted in alignment with the strategic intentions, the enterprise's business-critical policies can be cap-
tured and the facets of the IT architecture that are impacted by the policies can be identified and reviewed 
in regular time intervals. 

The Business IT Synchronization capability supports a bottom-up definition of IT’s strategic plan, ensuring 
that the IT architecture is developed in alignment with the companies policies and strategic intentions. 
Once the operational business support that is provided by applications has been captured, the current op-
erational support can be analyzed and the enterprise's medium-term and long-term IT can be planned in 
the context of the enterprise's IT strategy. 

Well-defined IT strategies allow the enterprise to describe the target architecture that is best suited to sup-
port the enterprise's underlying business strategy. The IT strategy represents a long-term target for the 
enterprise and provides the IT organization with a clear overview of the relevant aspects of the IT land-
scape in order to understand how strategic decisions will and should impact the IT’s tactics and direction 
over time. IT strategy planners can explore tactical options for rolling-out applications, ensure that flexibil-
ity in the IT architecture is accommodated, and confirm that IT planning is in alignment with the business' 
strategic vision. The roadmap describing the medium-term tactical business supports can then be docu-
mented as described in the section Target Architecture Design. 

The following information is available regarding the Business IT Synchronization capability: 

• Documenting the Enterprise's Policies 

• Understanding Governance and Responsibility for Policies 

• Capturing the Enterprise's Policies 

• Associating Policies with the Enterprise's Strategic Intentions 

• Prerequisites: Configuration Required for Policy Definition 

• Designing the Enterprise's IT Strategy 

• Methodology: Conceptualizing the IT Support for the Target Architecture 

• Methodology: Understanding Strategic Business Supports 

• Methodology: Conceptualizing Non-IT Support for the Target Architecture 

• Methodology: Using Blueprints to Plan the To-Be and Target Architectures 

• Understanding Governance and Responsibilities for IT Strategies 

• Specifying an IT Strategy for the Target Architecture 

• Planning the Strategic Business Support in a Business Support Map 

• Analyzing the Strategic Business Support and IT Strategy 

• Associating an IT Strategy with the Enterprise's Strategic Intentions 
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• Prerequisites: Configuration Required for Strategy Planning 

 
Please note a context-sensitive Help is available for each view available in the Business IT Syn-
chronization capability. You should refer to the Help if you require an explanation about the func-
tionalities and information available in a specific view. 

Documenting the Enterprise's Policies 

One aspect of the Business IT Synchronization capability focuses on documenting and managing the en-
terprise's policies in order to articulate the guidelines of business that should be followed in order to ensure 
that business is conducted in alignment with the strategic intentions and that aspects of the IT architec-
ture that are impacted by a policy can be identified and reviewed in regular time intervals. 

A policy is a guideline or rule of business or conduct that must or should be followed by the enterprise and 
its constituents. A policy can be associated with a strategic intention or a principle. The policy will have a 
start and end date and can have a review date specified. Each policy can be associated with architecture 
elements that are impacted by the policy as well as the architecture elements that implement the policy. 
Policies can be structured in one or more policy groups. 

The following information is available: 

• Understanding Governance and Responsibility for Policies 

• Capturing the Enterprise's Policies 

• Associating Policies with the Enterprise's Strategic Intentions 

• Prerequisites: Configuration Required for Policy Definition 

 
Please note a context-sensitive Help is available for each view available in the Business IT Syn-
chronization capability. You should refer to the Help if you require an explanation about the func-
tionalities and information available in a specific view. 

Understanding Governance and Responsibility for Policies 

A number of governance concepts are implemented in the Policy Management functionality : 

• Authorized User: Each policy has an authorized user. 

• Policy Groups: Policies may be structured in one or more policy groups. Each policy group has an 
authorized user. The authorized user of a policy group will have access permissions to all policies in 
the policy group. 

• Object Class Stereotypes: Object class stereotype may be configured by your solution designer 
for the object classes Policy and Policy Group. Stereotyping allows for various governance 
approaches to be implemented. 
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Capturing the Enterprise's Policies 

Policies must be assigned to a policy group. Therefore, you must first create the policy group that you want 
to assign the policy to. You can create multiple policy groups. Each policy group may contain an unlimited 
number of policies. A policy may be assigned to multiple policy groups. 

1) Create a policy group. Click the Policy Explorer  icon to access the Root Policy Groups Page 
View, where you can create all policy groups at the top level of the policy group hierarchy. 
Subordinate policy groups can be created in the Policy Sub-Groups Page View available for the 
parent policy group.. 

2) Create a policy. Click a policy group in the Policy Explorer to access the Policies Page View, 
where you can create all policies assigned to the policy group. Please keep the following in mind 
when creating a policy.  

• A new policy may be based on an Object class stereotype. 

• A policy will have a start and end date and may have an object state. The default state is 
Active. 

• A policy may have a review date. 

• A policy may have a principle associated with it. A principle is an overarching guideline that 
directs the enterprise architecture definition and decision-making across the company. An 
organization is responsible for the principle. 

• A policy may have a regulatory or legislative reference documented. 

3) Define the architecture objects that are impacted by the policy. This information is captured 
in the Affected Architecture Elements Page View of the policy. All policies impacting an object are 
displayed in the Affecting Policies Page View for the affected object. The Policies Without Affected 
Architecture Elements Page View displays all policies that are not defined to impact an 
architecture element. 

4) Define the architecture objects that implement the policy. This information is captured in the 
Implementing Architecture Elements Page View. The Finding Policies That Are Not Implemented 
Page View displays all policies that are not implemented via an architecture element.  

 
Please note that an object may be impacted by the policy as well as an object that imple-
ments the policy. 

5) Redefine the policy, if necessary. The Redefining Policies Page View allows you to redefine the 
selected policy by one or more other policies. When a policy is redefined, the selected policy is 
typically phased out and replaced by a more well-defined policy or a set of more granular policies. 
The object state of the selected policy can be changed, as needed, in the policy's object profile. If 
policy stereotypes have been configured, then only policies based on permissible policy 
stereotypes may be created to redefine an existing policy. 

Associating Policies with the Enterprise's Strategic Intentions 

A policy may be associated with a strategic intention. This articulates that the strategic intention conforms 
to the enterprise's guidelines. A strategic intention in Alfabet is represented by the class Value Node. Value 
nodes are based on value node stereotype that are structured in a hierarchy. Value nodes assigned to a 
top-level value node stereotype represent a highly abstract strategic intention (for example, Become an 



 
 Chapter 4: Business IT Synchronization 

Alfabet 10.15 ©2022 Software AG. All rights reserved. Reference Manual 21 

Integrated Financial Service Provider) whereas the leaf-level value nodes typically describe the action 
needed to realize the ascendant strategic intention. Thus, the value node stereotype at the lowest level 
usually represents strategic initiatives (for example, Establish New Credit & Loans Management Solu-
tion).The policy can be associated with a value node in the Value Node field in the Policy editor. 

 

Strategic intentions (value nodes) can be captured, tracked, and evaluated in the context of the 
Business Strategy Validation capability, which is available in the IT Planning Complete sales 
package. 

Prerequisites: Configuration Required for Policy Definition 

The following configuration is possible in order to work with policies: 

• If necessary, configure object class stereotypes for the object classes Policy (ITPolicy) and 
Policy Group (ITPolicyGroup). Mulitiple hierarchies of policy stereotypes may be configured by 
your solution designer in the XML object ITPolicyManager available in the configuration tool 
Alfabet Expand. For more information about the configuration of policy stereotypes, see the 
section Configuring the Policy Hierachy in the reference manual Configuring Alfabet with Alfabet 
Expand. 

• Configure solution requirements for each policy stereotype as you would for a conventional object 
class. You can configure one or more custom editors, custom selectors, custom wizards, custom 
object views, custom reports, etc. for each policy stereotype. You must ensure that the Affecting 
Policies Page View is assigned to the custom object view of the relevant object classes that might 
be defined as impacted by a policy. 

• Ensure that the Policy Explorer (ITPLCG_Explorer) functionality is available for the relevant user 
profile(s). 

• Notification monitors may be configured to inform responsible users when the policy review is 
impending. For more information about configuring notification monitors, see the section Defining 
Notification Monitors in the reference manual User and Solution Administration. 

Designing the Enterprise's IT Strategy 

A first step to qualify the value of IT with minor effort is to understand an application's operational business 
supports. A simple assignment of your enterprise's applications to the supported business processes re-
veals first high-level information about redundancies and gaps in the IT infrastructure. Once the current IT 
landscape has been analyzed and the applications relevant for consolidation or sundowning have been 
identified, one or more IT strategies can be articulated in order to plan the enterprise's target architecture. 
The goal is to design a strategic map that provides a long-term vision of the strategic business supports 
necessary for the enterprise's target architecture. 

Later, simple impact analysis can be executed in order to ultimately plan the migration from the as-is archi-
tecture to the target architecture. With a clearly articulated IT strategy in place, medium-term master plans 
can be specified to capture the roll-out of tactical business supports and migration plans can be devised to 
migrate the business support. The specification of master plans for the intermediate to-be architecture is 
described in the chapter Target Architecture Design. 

The following information is available: 
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• Methodology: Conceptualizing the IT Support for the Target Architecture 

• Methodology: Understanding Strategic Business Supports 

• Methodology: Conceptualizing Non-IT Support for the Target Architecture 

• Methodology: Using Blueprints to Plan the To-Be and Target Architectures 

• Understanding Governance and Responsibilities for IT Strategies 

• Specifying an IT Strategy for the Target Architecture 

• Planning the Strategic Business Support in a Business Support Map 

• Analyzing the Strategic Business Support and IT Strategy 

• Associating an IT Strategy with the Enterprise's Strategic Intentions 

• Prerequisites: Configuration Required for Strategy Planning 

 
Please note a context-sensitive Help is available for each view available in the Business IT Syn-
chronization capability. You should refer to the Help if you require an explanation about the func-
tionalities and information available in a specific view. 

Methodology: Conceptualizing the IT Support for the Target Architecture 

The target architecture represents the desired long-term status of the IT landscape without any specific 
timeframe or concrete references to applications. The target architecture usually resembles a strategic 
guideline rather than a detailed architectural plan and is captured in an IT strategy. Because the IT strategy 
represents a long-term target for an enterprise, it is not defined for an explicit period of time. Ultimately, 
the IT strategy provides direction for the master plan which represents the incremental transformation of 
the as-is architecture to the strategic target architecture. 

The IT strategy describes the entirety of business supports that shall ideally be in use within the enterprise. 
Because the IT strategy is subject to regular reviews and redefinition, multiple IT strategies may exist that 
differ for varying long-term business scenarios. For example, an IT strategy may be defined for an assumed 
market growth of 40 % as well as one for a market growth of only 20%. 

Planning the IT strategy allows for the analysis of the alignment of the prescribed strategic business sup-
port along the requirements of the enterprise's business processes and organizations. An IT strategy may 
have one or more IT strategy maps that allow strategy planning to be divided into domains of responsibility, 
affinity, or commonality. 
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The IT strategy map includes a business support map that is implemented to understand and analyze the 
current operational business supports and the prescribed strategic business supports. The business sup-
port map depicts the targeted state of the IT without a time frame and without the definition of specific ap-
plications as business support providers. The business support map constitutes a matrix made up of busi-
ness processes on the X-axis and organizations on the Y-axis that shall be supported. The matrix cells dis-
play the strategic business supports that prescribe the future support for the business. Typically, the pro-
viders of the strategic business supports are existing or planned ICT objects or virtual ICT objects with no 
time-specific object state. The matrix may also display the current and approved operational business sup-
ports so that the strategic planner can understand which applications are currently in use, which might be 
consolidated or sundowned, and which new technologies shall be introduced. 

To support strategic planning, blueprints may be drafted that provide guidelines for the strategic business 
support according to your enterprise’s prescribed standards. Blueprints will provide information about 
which objects should ideally be implemented as the provider of the business support. Blueprints can be 
used across various IT strategies and implemented in the context of strategy planning to ensure con-
sistency and standardization in the enterprise. The use of blueprints is described in more detail in the sec-
tion Methodology: Using Blueprints to Plan the To-Be and Target Architectures. 

Methodology: Understanding Strategic Business Supports 

In Alfabet, a strategic business support is a planned business support defined for an unspecified timeframe 
in the context of the long-term target architecture. Strategic business supports typically provide support 
to business processes and are typically executed by organizations responsible for the business processes. 
In contrast to an operational business support, which has an object state and typically inherits the lifecycle 
of the providing application, strategic business supports are defined for an unspecified timeframe and have 
no object state. 

 
In some industry segments, it is more relevant to analyze the business support for market prod-
ucts than for organizations. If this is the case, market products may be configured for the Y-di-
mension of the business support. Furthermore, some enterprises may describe business sup-
ports to provide support to domains or business capabilities of the business rather than business 
processes. If this is the case, domains (business capabilities) may be configured for the X-dimen-
sion of the business support. The configuration of the X-dimension and Y-dimension of business 
supports will apply to operational business supports, solution business supports, strategic busi-
ness supports, and tactical business supports. 
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For the sake of simplicity, the documentation will describe business processes on the X-dimen-
sion and organizations on the Y-dimension of business supports and business support maps. If 
your enterprise uses different object classes on the X- and Y-dimensions, please substitute the 
appropriate object class for the X- and or Y-dimension. 

Your solution designer will configure which object classes may be specified as a provider of strategic busi-
ness supports. Strategic business supports may be provided by ICT objects, virtual ICT objects, solution 
building blocks, or organizations. It may be that more than one object class is configured to be a business 
support provider. Configuration requirements are described in more detail in the section Prerequisites: 
Configuration Required for Strategy Planning. 

The strategic business support typically specifies an ICT object that is planned to provide support to the 
enterprise to carry out its business. An ICT object is an abstract object that can represent an application 
regardless of its versioning. 

  

An ICT object is owned by an organization that is usually responsible for the budget of the architecture ele-
ments assigned to the ICT object. As such, ICT objects serve as a container for future applications and are 
key to strategy planning. The use of ICT objects is advantageous in that the planner must not initially com-
mit him/herself to a certain version of an application. Later, at the stage of detailed master planning, the 
ICT object can be replaced by a specific concrete application version., 

  

In addition to specifying an ICT object as the provider of a business support, a virtual ICT object may be 
specified that represents a visionary ICT object that is not yet to be defined in the inventory but is needed 
ad-hoc to represent a strategic business support. Strategic business supports based on virtual ICT objects 
are relevant when changes are planned for the future and no decisions regarding technology have been 
finalized. These supports should be used very rarely. Instead, you should consider using ICT objects with a 
Draft release status so that budgets can be planned and the business architecture can be scoped. 
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A virtual ICT object is for planning purposes only and is not visible anywhere outside of the areas of strat-
egy planning or master planning. The virtual ICT object can later be replaced with a real ICT object or appli-
cation version. 

  

Alternatively, if your enterprise describes its functional planning as endorsed by TOGAF, it may be that a 
solution building block is configured to be the provider of a strategic business support. A solution building 
block (SBB) supports functional planning of the target architecture. A solution building block is considered 
to be an abstract functional prototype of an application and thus logically sits between its governing ICT 
object and the specified application, component, or standard platform that will be implemented at a later 
date. The methodology of solution building blocks is described in more detail in the section Methodology: 
Implementing Solution Building Blocks as Planning Objects. 

Some enterprises will also opt to capture non-IT support as a form of strategic business support. Non-IT 
support typically consists of support via internal services, external services, shared services, etc. that are 
provided by organizations. For more information regarding the strategic planning of non-IT support, see the 
section Methodology: Conceptualizing Non-IT Support for the Target Architecture. 

Strategic business supports are typically created in the Business Support Map Page View defined for an IT 
strategy map that prescribes architecture scenarios relevant for the IT strategy it was created for. Strate-
gic business supports may also be displayed in the context of a master plan map in order to provide a 
guideline for master planning and the creation of tactical business supports. For more information about 
master planning, see the chapter Target Architecture Design. 

Methodology: Conceptualizing Non-IT Support for the Target Architecture 

Non-IT support that supports the enterprise's business can also be specified for the target architecture. 
Strategic business supports as well as tactical business supports provided by organizations are relevant 
when changes are planned for activities conducted by service-providing organizations. Non-IT support 
typically consists of support provided via internal services, external services, shared services, etc. 

 
The following information describes the requirements to no-IT support for an IT strategy, but the 
specification of is similar for a master plan expect that the specification occurs in the context of 
the Review To-Be Architecture Functionality and the definition is made for a master plan map 
(instead of an IT strategy map). 
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If your enterprise wants to capture non-IT support, then you must configure strategic business supports 
where an organization is defined as the provider. In the case of non-IT business support, a strategic busi-
ness support would be modeled as follows: 

  

Non-IT support can be captured in the context of the Business Support Map Page View for an IT strategy 
map. The methods to capture strategic business support provided by organizations is the same as for IT 
support provided by ICT objects. If your solution configuration allows operations to be specified as the pro-
vider of a strategic business support, then the Create Strategic Business Support (Organization) option 
will be available in the context of the Business Support Map Page View. For more information about creat-
ing strategic business supports, see the section Planning the Strategic Business Support in a Business 
Support Map. 

 

Please note that all strategic business supports captured in a business support map will also be 
displayed in other views such as the Business Support Map Report Page View available for the IT 
strategy map. Therefore, if you want to analyze support provided via ICT objects and support via 
organizations separately, it is recommended that you define two IT strategy maps for the IT 
strategy. In this case, one IT strategy map should be dedicated to capturing and analyzing the 
strategic business support provided via ICT objects and the other IT strategy map should be 
dedicated to capturing and analyzing the strategic business support provided via organizations. 
In this way, you can separately analyze the IT support and non-IT support for your enterprise. 
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Methodology: Using Blueprints to Plan the To-Be and Target Architectures 

A blueprint is an IT strategy or master plan that serves as a guideline for planning the business support 
across organizations and contributes to standardization and efficiency in the roll-out of IT support in the 
enterprise. In the planning process, the planner can display the blueprint in a business support map for ref-
erence purposes when defining the strategic business supports in the context of an IT strategy map as well 
as defining tactical business supports in the context of a master plan map. Multiple blueprints can be cre-
ated for an IT strategy or master plan to address different planning scenarios. 

 
The following information describes the requirements to define a blueprint for an IT strategy, but 
the specification of a blueprint is similar for a master plan expect that the specification occurs in 
the Review To-Be Architecture Functionality and the definition is made for a master plan (instead 
of an IT strategy). 

The blueprint consists of the preferred business support map(s) to be used. In the case of a blueprint strat-
egy, strategic business supports are specified in the Business Support Map Page View for an IT strategy 
map. The blueprint strategy can then be used to create strategic business supports in other IT strategies as 
well as a guideline to create tactical business supports in the context of a master plan. A blueprint can also 
be created showing tactical business supports in the Business Support Map Page View for a master plan 
map. 

If multiple IT strategy maps have been defined for the blueprint strategy, then the blueprint definition in all 
IT strategy maps defined for the IT strategy will be embedded in the business support map if the blueprint 
strategy is selected. This allows you to copy IT strategy maps from other IT strategies and reuse or modify 
the blueprints for a selected IT strategy. This same concept applies to blueprints defined for master plan 
maps defined for a master plan. 

  

The image above displays the blueprint specified for the IT strategy Trading Blueprint Plan. The proto-
organization Trading Blueprint has been added to the Y-axis and the strategic business support Unified 
Trading Solution has been specified for the business processes Asset Class Trading, Hedging, and Se-
curitization and Issuance. 
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In the business support map for the IT strategy map Overview: Trading displayed above, Trading Blue-
print Plan is selected in the Blueprint filter field and is now embedded in the business support map. The 
prescribed strategic business supports defined in the blueprint are displayed for the business processes 
Asset Class Trading, Hedging, and Securitization and Issuance in the first row in the matrix. The strate-
gic planner can thus refer to the blueprint to plan the strategic business supports for the organizations FD 
Trading, OR Trading, and WP Investments. Ideally, when a business support map is defined for an IT strat-
egy, the strategy planner will create strategic business supports that are aligned with the blueprint's busi-
ness supports, but the strategy planner is free to deviate from the blueprint. 

The business supports in the blueprint must be defined as you would define business supports for a con-
ventional business support map. Information about defining a business support map is described in the 
sections Planning the Strategic Business Support in a Business Support Map and Planning the Tactical 
Business Support in a Business Support Map. Please keep the following in mind when defining the blue-
print: 

• The IT strategy owning the blueprint must be specified as a blueprint strategy so that the blueprint 
may be embedded in business support maps.  

• To define an IT strategy as a blueprint strategy, open the IT Strategy editor available for the IT 
strategy and set a checkmark in the Is Blueprint checkbox. Multiple IT strategies may be 
specified as blueprints, but the user will only be able to select one blueprint strategy in the 
Business Support Map Page View. Please consider the following:  

• If an IT strategy is specified as a blueprint, then the specification of the business support 
maps for the IT strategy maps should only provide blueprint information. General strategic 
planning of the target architecture should not be carried out in a blueprint strategy. 

• If multiple IT strategy maps have been defined for the blueprint strategy, then the 
strategic business supports of all IT strategy maps defined for the IT strategy will be 
displayed in the business support map if the blueprint strategy is selected. 

• To define a master plan as a blueprint master plan, open the Master Plan editor available for 
the master plan and set a checkmark in the Is Blueprint checkbox. Multiple master plans may 
be specified as blueprints, but the user will only be able to select one blueprint master plan in 
the Business Support Map Page View. Please consider the following:  

• If a master plan is specified as a blueprint, then the specification of the business support 
maps for the master plan maps should only provide blueprint information. General master 
planning of the to-be architecture should not be carried out in a blueprint strategy. 

• If multiple master plan maps have been defined for the blueprint a master plan, then the 
tactical business supports of all master plan maps defined for the a master plan will be 
displayed in the business support map if the blueprint a master plan is selected. 

• Only one organization should be added to the Y-axis of the blueprint's business support map. This 
organization is typically an abstract entity that represents a particular kind of proto-organization. 
In other words, only one row should be displayed on the Y-axis. If the organization assigned to a 
blueprint map is removed from the IT strategy map/master plan map in which the blueprint is 
embedded, the organization will not be removed from the blueprint. The blueprint organization and 
its associated business supports will continue to be displayed in business support map if the 
blueprint is selected in the Blueprint filter. 

• Multiple business processes may be added to the X-axis in order to define the blueprint business 
supports for the respective business processes. 
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• Only one IT strategy map should be created per IT strategy that is specified as a blueprint strategy. 
However, multiple IT strategies may be specified as blueprint strategies. An existing blueprint 
created for an IT strategy (A) can be embedded in a blueprint created for another IT strategy (B). 
This allows blueprints to be reused across the enterprise. To integrate an existing blueprint in the 
blueprint you are currently working with, select the relevant IT strategy in the Blueprint filter of 
the Business Support Map Page View. When a user selects a blueprint, all blueprints embedded in 
the selected blueprint will be displayed. You could similarly embed multiple blueprints associated 
with the a master plan maps defined for a master plan. 

Once a blueprint has been created, it can be embedded in a business support map in the context of an IT 
strategy as well as a master plan in order to provide a guideline when planning strategic and tactical busi-
ness supports. The blueprint can be displayed in any Business Support Map Page View by selecting the rel-
evant IT strategy in the Blueprint filter of the view. Please note the following: 

• Business supports defined for a blueprint only provide guidance for the planning process. The 
business supports displayed in the business support map for a selected blueprint cannot be copied 
via a right-click or drag-and-drop action in order to create new business supports in the business 
support map. However, a mechanism to copy the blueprint business supports is available via the 
Business Support Map Assistant editor. 

• If a blueprint is selected in the Business Support Map Page View, it will automatically be displayed 
in the Business Support Map Report Page View. The Blueprint filter can be changed as needed. 

• The Business Support Map Report Page View for a master plan map allows you to select the 
options View > Join Items and View > Y-Oriented in order to assess the alignment of business 
supports defined for the blueprint organization and the organizations relevant to the master plan 
map.. 

• The Master Plan Comparison Report Page View for a master plan map allows you to check for 
alignment and standardization between two master plans and compare the tactical business 
supports defined in the blueprint master plan with the business supports defined in another 
master plan for your organization 

Understanding Governance and Responsibilities for IT Strategies 

A number of governance concepts are implemented in the context of strategy planning: 

• Authorized User: Each IT strategy has an authorized user and each IT strategy map has an 
authorized user. The authorized users may be different individuals. 

• Mandates: IT strategies may be managed in a federated architecture. 

Specifying an IT Strategy for the Target Architecture 

The Plan Target Architecture Functionality allows you to define one or more IT strategies that describe the 
long-term target architecture. Several target architectures may be defined that differ for varying long-
term business scenarios for the enterprise. An IT strategy can be created for each alternative target archi-
tecture. For each IT strategy, you can specify multiple IT strategy maps that focus on different functional 
perspectives of the enterprise. The IT strategy map proposes the strategic business supports for the IT 
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strategy and can later be used as a guideline to define master plans and plan tactical business supports 
that serve as a roadmap for operational planning. 

The contributors to the definition of the IT strategy include application experts who might provide func-
tional descriptions and suggestions about the implementation of the proposed applications, business rep-
resentatives who might express business needs and contribute to organizational acceptance of the strat-
egy, and analysts and enterprise architects who might provide analyses of the current use of applications 
and help plan and monitor the roadmap execution. Process owners might review and approve the strategic 
recommendations and manage the release of the IT strategy. 

The following tasks should be carried out: 

1) Create an IT strategy. The IT strategy is created in the view displayed when the root node of the 
IT Strategy Manager Explorer is clicked. The IT strategy requires a name and should have an 
adequate description providing information about the strategy. When you create an IT strategy, 
you can specify whether it is a blueprint strategy to be used as a guideline for planning other IT 
strategies. In the planning process, strategic planners can refer to the blueprint strategy to plan 
strategic business supports in business support maps. The use of blueprints is explained in the 
section Methodology: Using Blueprints to Plan the To-Be and Target Architectures. 

2) Create one or more IT strategy maps for the IT strategy. An IT strategy map is the means to 
plan the strategic business support for a set of organizations and a set of business processes. 
Depending on your organization, you may create just one IT strategy map for an IT strategy or you 
may create multiple IT strategy maps to provide alternative scenarios for an IT strategy or to 
address the strategic planning needs for different organizations or business processes. An IT 
strategy map is created in the IT Strategy Maps Page View available for the IT strategy. The IT 
strategy map can be created from scratch or it can be created explicitly for a strategic intention 
(value node). If you create an IT strategy map for a strategic intention, the name of the IT strategy 
map will be the same as the name of the value node that it is based on. This can be changed if 
needed.  

 

Strategic intentions (value nodes) can be captured, tracked, and evaluated in the con-
text of the Business Strategy Validation capability, which is available in the IT Planning 
Complete sales package. 

3) Create IT strategy folders and structure the IT strategy maps in them, if necessary. IT 
strategy maps may be grouped into folders to allow for ease in navigation and analysis. Click an IT 
strategy in the IT Strategy Manager Explorer to access the IT Strategy Folders Page View to create 
folders. 

4) Define the objects that are preferred as providers of the strategic business support. An IT 
strategy map may feature a set of preferred architectural elements to be used when defining 
strategic business support in the business support map. Depending on your solution configuration, 
the providers of strategic business support may be ICT objects, solution building blocks, or 
organizations. Virtual ICT objects cannot be specified as a preferred provider. The objects that are 
preferred as support providers are specified in the Preferred Objects Page View available for the IT 
strategy map. The preferred objects will be available in the Preferred ICT Objects tab in the 
selector that opens when a strategic business support is created in the context of the Business 
Support Map Page View. 
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Planning the Strategic Business Support in a Business Support Map 

IT strategy maps allow for the analysis of the alignment of strategic business support in the IT architecture. 
An IT strategy map is graphically visualized in the Business Support Map Page View. The business support 
map is a matrix with an X-axis and a Y-axis. The X-axis will display the business processes that you want to 
plan support for and the Y-axis will display the organizations that require the support. The matrix cells con-
sist of the strategic business supports that provide support to corresponding business processes and or-
ganizations. 

 
In some industry segments, it is more relevant to analyze the business support for market prod-
ucts than for organizations. If this is the case, market products may be configured for the Y-di-
mension of the business support. Furthermore, some enterprises may describe business sup-
ports to provide support to domains or business capabilities of the business rather than business 
processes. If this is the case, domains (business capabilities) may be configured for the X-dimen-
sion of the business support. The configuration of the X-dimension and Y-dimension of business 
supports will apply to operational business supports, solution business supports, strategic busi-
ness supports, and tactical business supports. 

For the sake of simplicity, the documentation will describe business processes on the X-dimen-
sion and organizations on the Y-dimension of business supports and business support maps. If 
your enterprise uses different object classes on the X- and Y-dimensions, please substitute the 
appropriate object class for the X- and or Y-dimension. 

 

 

Your solution designer will configure which object classes may be specified as a provider of stra-
tegic business supports. Strategic business supports may be provided by ICT objects, virtual ICT 
objects, solution building blocks, or organizations. It may be that more than one object class is 
configured to be a business support provider. Configuration requirements are described in more 
detail in the section Prerequisites: Configuration Required for Strategy Planning. For an overview 
about strategic business supports, see the section Methodology: Understanding Strategic Busi-
ness Supports. 

Strategic business supports may be created in the Provided Strategic Business Support Page View of the 
ICT object that shall provide the strategic business support as well as the Strategic Business Support Page 
View of a supported business process or the Strategic Business Support Page View of the supporting or-
ganization. Strategic business supports will typically be created in these views by the users authorized to 
maintain the respective ICT objects, business processes, or organizations. These datasets allow users to 
create strategic business supports in a simple tabular dataset. 

A strategic planner will typically plan the strategic business support for the enterprise in a business support 
matrix that provides an overview of many business processes and organizations. Strategic business sup-
ports that have been created in the Strategic Business Support page views described above will auto-
matically be displayed for the respective business process/organization in the Business Support Map Page 
View of an IT strategy map. 



 
 Chapter 4: Business IT Synchronization 

Alfabet 10.15 ©2022 Software AG. All rights reserved. Reference Manual 32 

  

 FIGURE: Strategic planning in the Business Support Map page view 

 

Business support maps convey a wealth of information about the IT support planned in your en-
terprise. It is recommended that you familiarize yourself with the functionalities and view op-
tions available in business support maps before defining and analyzing your IT support. For more 
information about working with business support maps, see the section Appendix:Working with 
Business Support Maps. 

The following tasks are typically carried out in the Business Support Map Page View of an IT strategy map 
in order to create strategic business supports: 

• Specify the business processes and organizations for which you plan to define strategic 
business supports on the X- and Y-axis of the business support map. Unless your solution is 
configured differently, business processes will be displayed per default on the X-axis and 
organizations will be displayed on the Y-axis. Depending on the concept of business supports in 
your enterprise, domains may be implemented instead of business processes and market products 
may be implemented instead of organizations. Add the relevant objects to the X- and Y-axis via 
the New menu in the Business Support Map Page View. For more information about defining the 
axes of the business support map, see the section Setting Up the X- and Y-Axes of the Business 
Support Map. 

• Display a blueprint as a guideline for creating strategic business supports. If your enterprise 
implements blueprint planning, select the relevant IT strategy in the Blueprint field. The blueprint 
organization will be displayed as a dark blue matrix cell and will be the first organization/market 
product on the Y-axis. The defined blueprint business supports will be displayed in blue in the 
respective matrix cells in the first row of the Y-axis. Please note that the blueprint business 
supports are a means of visual guidance for the planning process. The strategic business supports 
defined in the blueprint cannot be copied via a right-click or drag-and-drop action when creating 
new strategic business supports. For more information about creating blueprints, see the section 
Methodology: Using Blueprints to Plan the To-Be and Target Architectures. 

• Create new strategic business supports for the relevant business processes and 
organizations. Click Strategic BSP > Create Strategic Business Support (<Provider>) and click 
in the relevant matrix cell. The business support provider you select will depend on your 
enterprise's methodology. If objects have been defined in the Preferred Objects Page View, you 
can select them in the Preferred tab in the object selector. Define the release status of the new 
strategic business support and provide a meaningful description about the planned strategic 
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business support. You can also specify the business services that the strategic business support 
shall provide and the operational aspects that describe the specific dimensions that will be 
supported via the business services. 

• Create new strategic business supports based on a copy of an existing strategic business 
support. In the matrix, select the strategic business support to copy and click the CTRL key and 
drag-and-drop the business support to the relevant cell in the matrix. The object (ICT object, 
organization, solution building block, etc.) providing the business support, the release status, the 
provided business services, and the operational aspects will be copied to the new business 
support. 

• Replace virtual ICT objects providing strategic business supports with ICT objects. In the 
matrix, select the strategic business support and click New > Replace Virtual Object with ICT 
Object. In the selector, select the relevant ICT object. Please note that if the strategic business 
support has been copied to other business processes or organizations in the business support 
map, all copied business supports based on the virtual ICT object will be automatically updated 
with the selected ICT object. If you replace a virtual ICT object with an ICT object that is already 
providing strategic business support to a business process and organization, you will have 
redundant strategic business supports in the same matrix cell. In this case, you will need to 
manually remove the redundant strategic business supports. 

• Move strategic business supports to a different business process or organization. In the 
matrix, select the strategic business support to move and drag-and-drop the business support to 
the relevant cell in the matrix. 

• Remove strategic business supports that are not relevant for the IT strategy. In the matrix, 
select the strategic business support and click the Detach button. The strategic business support 
will be removed from the business support map but will not be removed from the Alfabet database. 

• Delete strategic business supports that are not relevant for the strategic planning. In the 
matrix, select the strategic business support and click the Delete button. The strategic business 
support will be removed from the business support map but will be irrevocably deleted from the 
Alfabet database. 

Analyzing the Strategic Business Support and IT Strategy 

 

Business support maps convey a wealth of information about the IT support planned in your en-
terprise. It is recommended that you familiarize yourself with the functionalities and view op-
tions available in business support maps before defining and analyzing your IT support. For more 
information about working with business support maps, see the section Appendix:Working with 
Business Support Maps. 

The following views allow you to understand the planned target architecture in more detail: 

• The Business Support Map Report Page View for an IT strategy map displays the prescribed 
business support for the selected IT strategy map. The following view options are available to 
analyze the strategic business support:  

• In order to understand where business supports are aligned across business 
processes/domains, you can display the business supports for which the same provider and 
aspects are defined as a single matrix object that is joined across the common business 
supports. In this way, you can assess where support is aligned vs. where new business 
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supports are needed in order to reduce misalignment. Click the View Options button in the 
toolbar to open the Business Support Map Report Options editor. In the Details tab, select 
the option Join Items to align the business supports with a common provider defined. 

• In order to under the object states of business support providers, the business support, and 
the aspect values defined for the business support, click the View Options button in the 
toolbar to open the Business Support Map Report Options editor. In the Details tab, select 
the option Show Attributes. A small box with the information will be displayed on the right 
edge of the business supports in the matrix. 

• Color rules allow you to cluster and color a specific set of objects in business support maps 
based on queries determined by your enterprise. For example, color rules could be configured 
to highlight operational costs of the ICT objects providing the business support. All objects 
found in the result set of the associated queries will be highlighted in the view. To display color 
rules, click the View Options button in the toolbar to open the Business Support Map Report 
Options editor. In the Details tab, select the option Use Color Map. The business supports will 
be highlight with color based on the configured color rules. 

• The Business Process Portfolio Page View and Organization Portfolio Page View respectively 
display the business processes or organizations relevant for the selected IT strategy map. 
Configured portfolios allow you to understand the relative performance of the business 
processes/organizations based on two or three independent dimensions of measurement. For 
example, a portfolio could be configured by your enterprise to display the estimated risk to 
business processes or the significance of the business processes to the business. 

• Various reports provide insight into the potential gaps or redundancy of strategic business 
supports on operational aspects such as brands, customer segments, markets, and sales channels. 
Operational aspects are relevant in the context of planning and analysis of strategic business 
supports and allow the strategic planner to understand the contribution that a business process or 
organization makes to the business. Understanding the contribution of individual business 
supports to operational aspects sheds light on where future support is required in order to realize 
the enterprise's IT strategy.  

• The Business Process/Domain Aspect Analysis Page View for an IT strategy map provides an 
overview of the strategic business supports supporting the aspects relevant for a selected 
business process. The X-axis displays all aspects that are relevant for a selected business 
process. The matrix cells visualize the business supports contributing to the aspects, and the 
Y-axis displays all organizations that are supported by the business supports. 

• The Organization/Market Product Aspect Page View for an IT strategy map provides of the 
strategic business supports supporting the aspects relevant for a selected 
organization/market product. The X-axis displays all aspects that are relevant for a selected 
organization. The matrix cells visualize the business supports contributing to the aspects, and 
the Y-axis displays all business processes that are supported by the business supports. 

• The Strategy Comparison Page View for an IT strategy allows you to understand which strategic 
business supports are unique to and shared by the selected IT strategy and another IT strategy. 
For example, you could compare an IT strategy with a blueprint IT strategy to understand the 
degree of standardization that exists in the target architecture. The report compares which ICT 
objects support the business processes and organizations specified for the IT strategy maps 
defined for the IT strategies targeted by the comparison. 
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Associating an IT Strategy with the Enterprise's Strategic Intentions 

An IT strategy can be created explicitly for a value node in the IT Strategy Maps Page View. If this is the 
case, the value node will be displayed in the Impacting Value Nodes Page View available for the IT strategy. 
You can associate multiple strategic intentions with an IT strategy. 

The Impacting Value Nodes Page View available for the IT strategy displays all value nodes that impact the 
selected IT strategy. 

 

Strategic intentions (value nodes) can be captured, tracked, and evaluated in the context of the 
Business Strategy Validation capability, which is available in the IT Planning Complete sales 
package. 

Prerequisites: Configuration Required for Strategy Planning 

The following configuration is necessary to work with IT strategies: 

• The following must be configured in the XML object ITMapDef available in the configuration tool 
Alfabet Expand. For more information about all configuration possibilities for business matrices, 
see the section Configuring Standard Business Support Matrices in the reference manual 
Configuring Alfabet with Alfabet Expand.  

• Default object classes to display on the X-dimension and Y-dimension of business supports 
and business support matrices. 

• Default order of the axis objects. 

• Permissible object classes that may be the provider of strategic business supports. 

• Aspect groups and aspect values displayed on matrix objects. 

• Relevance values that allow users to filter information that lacks relevance for their current 
analysis of the IT landscape. 

• Ensure that the IT Strategy Manager Explorer (ITS_Explorer) is available for the relevant user 
profile(s). 

• If solution building blocks are implemented in master planning, the solution designer must ensure 
that the Target Architecture Planning workspace (ICTO_TargetArchitecture) is available in 
the custom object view of the relevant ICT object stereotype. The Target Architecture Planning 
workspace contains the views necessary to create and further define and analyze solution building 
blocks. 
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Chapter 5:  Target Architecture Design 

Alfabet provides a Target Architecture Design capability that enables IT architects to develop a clearly doc-
umented proposal to deliver IT solutions and services that are aligned with the enterprise’s IT landscape 
and business objectives. Alfabet’s patented master planning functionality is a keystone in translating the 
business strategy into IT tactics and allows IT planners to define, analyze, and communicate plans for the 
further evolution of the core IT assets. The master plan is a highly condensed representation of the IT stra-
tegic plan, and is an easy-to-comprehend, single point of reference, hence an excellent medium for discus-
sion at decision boards. The business supports managed in the master plan allow planners to define and 
communicate the roll-out plans through dedicated lifecycle definitions, explore tactical options, and ensure 
flexibility in the IT architecture. 

Alfabet’s master planning capabilities are used by IT and business strategists and planners as well as gen-
eral leadership roles across the business and IT. Available functionalities support these roles to define cur-
rent and future lifecycle plans for applications in the enterprise, analyze potential conflicts in the IT 
roadmaps, design various architectural scenarios, and ultimately specify the overall IT roadmap for the en-
terprise. By means of roadmapping the enterprise's to-be architecture, master planners will understand IT 
support for various aspects of the business thus enabling planning that is better aligned to the needs of 
individual business operational units. Validated blueprint master plans reduce the risk associated with the 
transition to a new to-be architecture and ensure the standardization of IT solutions across the enterprise. 
The Target Architecture Design capability supports your enterprise in standardizing and simplifying the en-
terprise architecture by reusing the same applications for the same business processes whenever possible, 
thereby executing the business's mission with fewer applications and a reduction in costs, maintenance 
efforts, and risks to the IT. 

The following information is available regarding the Target Architecture Design capability: 

• Methodology: Conceptualizing a Roadmap for the To-Be Architecture 

• Methodology: Understanding Tactical Business Supports 

• Methodology: Implementing Solution Building Blocks as Planning Objects 

• Specifying a Master Plan for the To-Be Architecture 

• Planning the Tactical Business Support in a Business Support Map 

• Analyzing the Master Plan 

• Prerequisites: Configuration Required for Master Planning 

 
Please note a context-sensitive Help is available for each view available in the Target Architec-
ture Design capability. You should refer to the Help if you require an explanation about the func-
tionalities and information available in a specific view. 

Methodology: Conceptualizing a Roadmap for the To-Be Architec-
ture 

Master planning is the process of defining plans for the to-be architecture and deciding when to introduce 
new applications as well as when to consolidate or sundown existing applications. The to-be architecture is 
a medium-term plan for the enterprise’s architecture and defines a clearly approved architectural guideline 
that is in alignment with the enterprise's IT strategy. 
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Master planning includes the analysis of the operational as-is architecture and a vision of the long-term 
target architecture in order to produce the roadmap for the IT architecture. As such, it is a mixture of bot-
tom-up planning in terms of understanding how the as-is architecture is currently supported and may con-
tinue to be supported, and top-down planning whereby the articulated IT strategy suggests the new tech-
nologies that shall be introduced to fulfill the enterprise's vision of the IT architecture. 

  

The planned consolidated to-be architecture is captured in one or more master plans which represent the 
IT roadmap - the incremental transformation of the as-is architecture to the medium-term to-be architec-
ture and ultimately to the long-term target architecture. Ideally, an established IT strategy will provide di-
rection for the master plan. The master plan captures the entirety of the tactical business supports that 
shall be planned for the enterprise's IT roadmap. 

Each master plan may have one or more master plan maps, which describes the actual roll-out plan depict-
ing how the current IT landscape will be migrated to the IT strategy. Master plan maps allow different do-
mains of responsibility, affinity, and commonality in the IT architecture to be captured as well as alternative 
scenarios that may be relevant for the master plan to be drafted. The master plan map includes a business 
support map that is implemented to understand and analyze the current operational business support, the 
prescribed strategic business support, and the planned tactical business support. The business support 
map typically constitutes a matrix made up of the supported business processes on the X-axis and organi-
zations on the Y-axis. The matrix cells display the tactical business supports defined to transition the sup-
port from the current as-is architecture to the strategic IT architect. 
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Existing operational business supports that support the displayed business processes and organizations 
can be included in the business support map. In this way, the tactical business supports can be created 
based on bottom-up planning starting with the operational as-is architecture. Operational business sup-
ports that have been retired may also be displayed. Simultaneously, prescribed strategic business supports 
can also be displayed to support top-down planning. The strategic business supports thus provide guide-
lines for the target architecture. 

A matrix cell with multiple operational business supports could indicate a potential redundancy in the ar-
chitecture whereas a matrix cell without any business supports could indicate a gap in the support of a 
business process. In this way, the master planner can understand where the same applications can be re-
used for the same business processes, which applications can be consolidated or sundowned, and which 
new technologies shall be introduced. 

Business support maps may be difficult to manage if the business support map is large and complex. In this 
case, one or more map views can be created for a master plan map in order to limit the business processes, 
organizations, and business supports displayed in the business support map. This allows the master plan-
ner to focus on specific aspects of the business support or provide map views to other authorized users 
that address the specific needs of that particular user involved in the master planning effort. 

To support master planning, blueprints may be drafted that provide guidelines for the tactical business 
support based on your enterprise’s standards. Blueprints provide information about which objects should 
ideally be implemented as the provider of the business support. Blueprints can be used across various mas-
ter plans to ensure consistency and standardization in the enterprise. The concept of blueprints is de-
scribed in detail in the section Methodology: Using Blueprints to Plan the To-Be and Target Architectures. 

Various functionalities in Alfabet support the analysis and review of tactical business support with regards 
to the as-is architecture, the provided business services, the time line of the roadmap, and the technical 
and strategic direction of the business. The master planner should review the alignment of the 
timeframe/lifecycles of the tactical business supports with those of the operational business supports as 
well as review the business services provided by the tactical and operational business supports. The 
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realization of the to-be architecture can be addressed by defining demands to request a change in the en-
terprise's IT landscape or by creating projects to initiate the action required to realize and implement the 
tactical roadmap and fill the gaps between the as-is and target architectures. 

Methodology: Understanding Tactical Business Supports 

Tactical business supports are central to master planning. In Alfabet, a tactical business support is a pre-
scribed business support defined for a specified timeframe in the context of the medium-term to-be archi-
tecture. Tactical business supports are typically created in the context of a master plan map in order to 
provide a guideline for master planning. Tactical business supports typically provide support to business 
processes and are typically executed by organizations responsible for the business processes. 

 
In some industry segments, it is more relevant to analyze the business support for market prod-
ucts than for organizations. If this is the case, market products may be configured for the Y-di-
mension of the business support. Furthermore, some enterprises may describe business sup-
ports to provide support to domains or business capabilities of the business rather than business 
processes. If this is the case, domains (business capabilities) may be configured for the X-dimen-
sion of the business support. The configuration of the X-dimension and Y-dimension of business 
supports will apply to operational business supports, solution business supports, strategic busi-
ness supports, and tactical business supports. 

For the sake of simplicity, the documentation will describe business processes on the X-dimen-
sion and organizations on the Y-dimension of business supports and business support maps. If 
your enterprise uses different object classes on the X- and Y-dimensions, please substitute the 
appropriate object class for the X- and or Y-dimension. 

Your solution designer will configure which object classes may be specified as a provider of tactical busi-
ness supports. Tactical business supports may be provided by current or planned applications, ICT objects, 
virtual ICT objects, solution building blocks, or organizations. Which type of object that shall be the provider 
of the tactical business support will depend on the master planning methodology implemented in your en-
terprise and the information you have available about the planned to-be architecture. It may be that more 
than one object class is configured to be a business support provider. For example, a convention for model-
ing the master plan might be to create new tactical business supports that are provided by ICT objects and 
make changes to existing operation business supports via tactical business supports provided by applica-
tions. Configuration requirements are described in more detail in the section Prerequisites: Configuration 
Required for Master Planning. 

Similar to operational business supports, which indicate which current or planned (approved and budgeted) 
applications are used in the as-is architecture, tactical business supports also have a start and end date 
and are thus time-related. However, tactical business supports do not have an object state and thus do not 
inherit the lifecycle of the application or ICT object providing the business support. 
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The tactical business support typically specifies an application that is planned to provide support to the en-
terprise to carry out its business. An application is a fully-functional integrated IT product that provides 
functionality to support the business to accomplish its mission. From a planning perspective, only the logi-
cal structure of applications and the business services and business supports they provide are of rele-
vance. 

Tactical business supports based on applications are suitable when changes are planned for the near fu-
ture and the application version is known. For example, when modifying the existing operational business 
support or phasing out an application. 

  

An ICT object is an abstract object that can represent an application regardless of its versioning. An ICT ob-
ject is owned by an organization that is usually responsible for the budget of the architecture elements as-
signed to the ICT object. As such, ICT objects serve as a container for future applications. The use of ICT 
objects is advantageous in that the planner must not initially commit him/herself to a certain version of an 
application. Later, at the stage of detailed master planning, the ICT object can be replaced by a specific 
concrete application version. 

Tactical business supports based on ICT objects are relevant when changes are planned for the future ( +2 
years) and the application version is not yet known. For example, when completely new business supports 
or IT systems are to be introduced. 
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In addition to specifying an ICT object as the provider of a business support, a virtual ICT object may be 
specified that represents a visionary ICT object that is not yet to be defined in the inventory but is needed 
ad-hoc to represent a tactical business support. A virtual ICT object is for planning purposes only and is not 
visible anywhere outside of the areas of strategy planning or master planning. These supports should be 
used only very rarely. Instead, you should consider using ICT objects with a Draft release status so that 
budgets can be planned and the business architecture can be scoped. 

Tactical business supports based on virtual ICT objects are relevant when changes are planned for the fu-
ture and no decisions regarding technology have been finalized. The virtual ICT object can later be replaced 
with a real ICT object or application version. 

  

Alternatively, if your enterprise describes its functional planning as endorsed by TOGAF, it may be that a 
solution building block is configured to be the provider of a tactical business support. A solution building 
block (SBB) supports functional planning of the target architecture. A solution building block is considered 
to be an abstract functional prototype of an application and thus logically sits between its governing ICT 
object and the specified application, component, or standard platform that will be implemented at a later 
date. The methodology of solution building blocks is described in more detail in the section Methodology: 
Implementing Solution Building Blocks as Planning Objects. 
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Some enterprises will also opt to capture non-IT support as a form of tactical business support. Tactical 
business supports based on organizations are relevant when changes are planned for activities conducted 
by service-providing organizations. Non-IT support typically consists of support via internal services, ex-
ternal services, shared services, etc. that are provided by organizations. The methodology to plan non-IT 
support via tactical business supports is similar to planning non-IT support via strategic business supports. 
For more information regarding the strategic planning of non-IT support, see the section Methodology: 
Conceptualizing Non-IT Support for the Target Architecture. 

Tactical business supports are typically created in the Business Support Map Page View defined for a mas-
ter plan map that describes a particular architecture scenario relevant for the master plan it was created 
for. 

  

In the context of master planning, you may be able to create tactical business supports based on existing 
operational business supports and strategic business supports. In this way, you can plan the tactical busi-
ness supports based on bottom-up planning starting with the operational as-is architecture as well as plan 



 
 Chapter 5: Target Architecture Design 

Alfabet 10.15 ©2022 Software AG. All rights reserved. Reference Manual 43 

the tactical business supports based on top-down planning by referring to the guidelines of the target ar-
chitecture. For more information about creating tactical business supports, see the section Planning the 
Tactical Business Support in a Business Support Map. 

Methodology: Implementing Solution Building Blocks as Planning 
Objects 

Some enterprises adopt a TOGAF approach to IT management processes. TOGAF supports a top-down 
planning process whereby solution building blocks are implemented as versionless placeholders that de-
scribe the functional needs of the target landscape. These placeholders are then re-defined as applications 
in the course of more detailed planning. By means of solution building blocks (SBBs), the strategy planner 
and master planner may focus on functional planning of the long-term target architecture and the medium 
term to-be architecture 

A solution building block is considered to be an abstract functional prototype of an application with no start 
and end dates and thus logically sits between its governing ICT object and the specified application, com-
ponent, or standard platform that will be implemented at a later date. A solution building block may be as-
signed to only one ICT object, whereas an ICT object may have multiple alternative solution building blocks. 
The definition of the solution building block includes the business services that the solution building block 
targets as well as the business objects and information flows that are used by the solution building block to 
realize the enterprise's business functions. 

  

In the context of master planning, a solution building block can be specified as a business support provider 
as well as a source or target object of a migration rule. The solution building block may be specified to pro-
vide a tactical business support or a strategic business support. If solution building blocks are implemented 
in strategy planning and master planning, ICT objects should only be used as governance and controlling 
objects. Please note that ff solution building blocks are implemented as a business support provider, ICT 
objects should not be defined to provide business supports. In this case, only solution building blocks 
should be specified as providers of strategic business supports. In the case of master planning, solution 
building blocks should be replaced by applications as providers of operational business support. 

To implement solution building blocks for strategy planning and master planning: 

• Create solution building blocks. Solution building blocks are created in the Solution Building 
Blocks Page View in the ICT object profile. If object class stereotypes have been configured by 
your solution designer for the class ICT Object, then usually the solution building blocks shall only 
be defined for specified stereotypes. 

• Specify which applications, components, or standard platforms will implement the solution 
building blocks. The implementation is defined in the Solution Building Block Implementations 
Page View in the ICT object profile. The object selected to be implemented must also be governed 
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by the selected ICT object. Only one object can be specified to implement the solution building 
block and an object may only implement one solution building block. 

• Define the business services provided by the solution building blocks in the Provided Business 
Services Page View of the solution building block. 

• Define the business objects provided by the solution building blocks in the Business Objects 
Page View of the solution building block. 

• Define the information flows exchanging the business objects provided by the solution 
building blocks in the Information Flows Page View of the solution building block. 

• Define the components, technologies and vendor products targeted by the solution building 
blocks in the Technology Page View of the solution building block. 

• Define the solution building block as the provider of relevant strategic business supports: 
The strategic business supports can be created in the Provided Strategic Business Support Page 
View or in the Business Support Map Page View in the context of planning an IT strategy for the 
target architecture. 

Specifying a Master Plan for the To-Be Architecture 

The Review To-Be Architecture Functionality allows you to define a master plan that describes the me-
dium-term to-be architecture. Several to-be architectures may be defined that differ for varying medium-
term business scenarios for the enterprise. A master plan can be created for each alternative target archi-
tecture. For each master plan, you can specify multiple master plan maps that focus on different functional 
perspectives of the enterprise. Master plan maps propose the tactical business supports for the master 
plan and can later be used as a roadmap for operational planning. 

The contributors to the definition of the master plan include application experts who might provide func-
tional descriptions and suggestions about the implementation of the proposed applications, business rep-
resentatives who might express business needs and contribute to organizational acceptance of the master 
plan, and analysts and enterprise architects who might provide analyses of the current use of applications 
and help plan and monitor the roadmap execution. Process owners might review and approve the tactical 
recommendations and manage the release of the master plan. 

The following tasks should be carried out: 

• Create a master plan. The master plan is created in the view displayed when the root node of the 
Review To-Be Architecture Functionality is clicked. The master plan requires a name and should 
have an adequate description providing information about the strategy. When you create a master 
plan, you can specify whether it is a blueprint to be used as a guideline for planning other master 
plans. In the planning process, master planners can refer to a blueprint to plan tactical business 
supports in business support maps. The use of blueprints is explained in the section Methodology: 
Using Blueprints to Plan the To-Be and Target Architectures. 

• Create one or more master plan maps for the master plan. A master plan map is the means to 
plan the tactical business support for a set of organizations and a set of business processes. 
Depending on your organization, you may create just one master plan map for a master plan or you 
may create multiple master plan maps to provide alternative scenarios for a master plan. Click a 
master plan in the Review To-Be Architecture Functionality to access the Master Plan Maps Page 
View. 
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• Create master plan folders and structure the master plan maps in them, if necessary. Master 
plan maps may be grouped into folders to allow for ease in navigation and analysis. Click a master 
plan in the Review To-Be Architecture Functionality to access the Master Plan Folders Page View 
to create folders. 

• Define the ICT objects, applications, solution building blocks, or organizations that are 
preferred as providers of the tactical business support. A master plan map may feature a set 
of preferred architectural elements to be used when defining tactical business support in the 
business support map. Depending on your solution configuration, the providers of tactical 
business support may be ICT objects, applications, solution building blocks, or organizations. The 
objects that are preferred as support providers are specified in the Preferred Objects Page View 
available for the master plan map. The preferred objects will be available in the Preferred ICT 
Objects, Preferred Applications, etc. tab that opens when a tactical business support is created 
in the context of the Business Support Map Page View. 

Planning the Tactical Business Support in a Business Support Map 

Master plan maps allow for the analysis of the alignment of tactical business support in the IT architecture. 

Tactical business supports may be created in the Provided Tactical Business Support Page View of the ap-
plication or the Provided Tactical Business Support Page View of the ICT object that shall provide the tacti-
cal business support as well as the Assigned Tactical Business Supports Page View of a supported busi-
ness process or the Tactical Business Support Page View of the supporting organization. Tactical business 
supports will typically be created in these views by the users authorized to maintain the respective applica-
tions, ICT objects, business processes, or organizations. These datasets allow users to create tactical busi-
ness supports in a simple tabular dataset. 

A master planner will typically plan the tactical business support for the enterprise in a business support 
matrix that provides an overview of many business processes and organizations. Tactical business sup-
ports that have been created in the Tactical Business Support page views described above will automati-
cally be displayed for the respective business process/organization in the Business Support Map Page View 
of a master plan map. 

 

Business support maps convey a wealth of information about the IT support planned in your en-
terprise. It is recommended that you familiarize yourself with the functionalities and view op-
tions available in business support maps before defining and analyzing your IT support. For more 
information about working with business support maps, see the section Appendix:Working with 
Business Support Maps. 

To capture the basic information for a master plan map in the Business Support Map Page View: 

• Specify the business processes and organizations for which you plan to define tactical 
business supports on the X- and Y-axis of the business support map. Unless your solution is 
configured differently, business processes will be displayed per default on the X-axis and 
organizations will be displayed on the Y-axis. Depending on the concept of business supports in 
your enterprise, domains may be implemented instead of business processes and market products 
may be implemented instead of organizations. Add the relevant objects to the X- and Y-axis via 
the New menu in the Business Support Map Page View. For more information about defining the 
axes of the business support map, see the section Setting Up the X- and Y-Axes of the Business 
Support Map. 
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• Display a blueprint as a guideline for creating tactical business supports. If your enterprise 
implements blueprint planning, select the relevant master plan in the Blueprint field. The blueprint 
organization will be displayed as a dark blue matrix cell and will be the first organization on the Y-
axis. The defined blueprint business supports will be displayed in blue in the respective matrix cells 
in the first row of the Y-axis. Please note that the blueprint business supports are a means of 
visual guidance for the planning process. The tactical business supports defined in the blueprint 
cannot be copied via a right-click or drag-and-drop action when creating new tactical business 
supports. For more information about creating blueprints, see the section Methodology: Using 
Blueprints to Plan the To-Be and Target Architectures. 

• Define the relevant display settings. The displays settings that you define for the Business 
Support Map Page View will be inherited by the other relevant reports available for the master plan 
map.  

• To ensure that you can create and display tactical business supports, click the View Options 
button and set a checkmark next to the option Show Tactical Business Support. 

• To include existing operational business supports in the matrix, click the View Options button 
and set a checkmark next to the option Show Operational Business Support. The operational 
business supports provide information about the as-is architecture and can be used as a basis 
to create tactical business supports with the same provider/business process/organization. 

• To include retired operational business supports in the matrix, click the View Options button 
and set a checkmark next to the option Show Retired Business Support. The retired 
operational business supports provide information about future gaps in the IT architecture. 

• To display the target strategic business supports in the matrix, select the relevant IT strategy 
in the IT Strategy field. The strategic business supports provide information about the 
prescribed target architecture and can be used as a basis to create tactical business supports 
with the same provider/business process/organization. 

• Create new tactical business supports for the relevant business processes and 
organizations. Click Tactical BSP > Create Tactical Business Support (<Provider>) and click in 
the relevant matrix cell. The business support provider you select will depend on your enterprise's 
methodology. If objects have been defined in the Preferred Objects page view, you can select 
them in the Preferred <Object Class> tab in the object selector. You should define the following for 
the new tactical business support:  

• The start date and end date of the tactical business support. The start and end dates of the 
tactical business support are independent of the start and end dates of the business support 
provider but they must be within start and end dates of the of the business support provider. 

• The release status of the tactical business support. 

• The business services that the tactical business support will provide. The list displays all 
business services provided by the business support provider. 

• The operational aspects that describe the specific dimensions that will be supported via the 
business services. 

• Create new tactical business supports based on a copy of an existing tactical business 
support. In the matrix, select the tactical business support to copy and click the CTRL key and 
drag-and-drop the business support to the relevant cell in the matrix. The object (ICT object, 
organization, solution building block, etc.) providing the business support, the release status, the 
provided business services, and the operational aspects will be copied to the new business 
support. 
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• Create new tactical business supports based on a copy of an existing operational business 
support. In the matrix, select the operational business support to copy and click New > Business 
Support Map Assistant. In the editor, select the relevant business process and organizations for 
which new tactical business support shall be created. The object (ICT object, organization, solution 
building block, etc.) providing the business support, the release status, the provided business 
services, and the operational aspects will be copied to the new tactical business support. 

• Create new tactical business supports based on a copy of an existing strategic business 
support. In the matrix, select the strategic business support to copy and click New > Business 
Support Map Assistant. In the editor, select the relevant business process and organizations for 
which new tactical business support shall be created. The object (ICT object, organization, solution 
building block, etc.) providing the business support, the release status, the provided business 
services, and the operational aspects will be copied to the new tactical business support. 

• Replace virtual ICT objects providing tactical business supports with ICT objects or 
applications. In the matrix, select the tactical business support and click New > Replace Virtual 
Object with ICT Object or New > Replace Virtual Object with Application. In the selector, select 
the relevant ICT object or application. Please note that if the tactical business support has been 
copied to other business processes or organizations in the business support map, all copied 
business supports based on the virtual ICT object will be automatically updated with the selected 
ICT object. If you replace a virtual ICT object with an ICT object or application that is already 
providing tactical business support to a business process and organization, you will have 
redundant tactical business supports in the same matrix cell. In this case, you will need to 
manually remove the redundant tactical business supports. 

• Move tactical business supports to a different business process or organization. In the 
matrix, select the tactical business support to move and drag-and-drop the business support to 
the relevant cell in the matrix. 

• Remove tactical business supports that are not relevant for the master plan. In the matrix, 
select the tactical business support and click the Detach button. The tactical business support will 
be removed from the business support map but will not be removed from the Alfabet database. 

• Delete tactical business supports that are not relevant for the master planning. In the matrix, 
select the tactical business support and click the Delete button. The tactical business support will 
be removed from the business support map but will be irrevocably deleted from the Alfabet 
database. 

• Associate the tactical business support with a project. You can associate a tactical business 
support with an existing project if, for example, the business support is impacted by the project. 
The object providing the business support as well as the associated organization and business 
process will be captured as architecture elements impacted by the project. Click Analyze > Map 
Objects Report. In the view that opens, select the tactical business support in the table and click 
Action > Assign Business Support to Project and select the project that impacts the business 
support. 

• Associate the tactical business support with a demand. You can associate a tactical business 
support with an existing demand if, for example, the business support is impacted by the demand. 
The object providing the business support as well as the associated organization and business 
process will be captured as architecture elements impacted by the demand. Click Analyze > Map 
Objects Report. In the view that opens, select the tactical business support in the table and click 
Action > Assign Business Support to Demand and select the demand that impacts the business 
support. You can also create a new demand for the tactical business support by clicking Action > 
Create Demand. 
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Analyzing the Master Plan 

 

Business support maps convey a wealth of information about the IT support planned in your en-
terprise. It is recommended that you familiarize yourself with the functionalities and view op-
tions available in business support maps before defining and analyzing your IT support. For more 
information about working with business support maps, see the section Appendix:Working with 
Business Support Maps. 

The following views allow you to understand the planned to-be architecture in more detail: 

• The Business Support Map Report for a master plan map displays the prescribed business support 
for the selected master plan map. You can do the following:  

• Aggregate business supports to either the ICT owning the business supports providing 
application or to the application version that an application variant providing the support is 
based on in order to check for alignment in the use of applications/ICT objects. To do so, click 
View Options and select the Aggregate to Application or Aggregate to ICT Object 
checkboxes 

• Analyze where business supports are aligned across business processes. You can display the 
business supports for which the same provider and aspects are defined as a single matrix 
object that is joined across the common business supports. In this way, you can assess where 
support is aligned vs. where new business supports are needed in order to reduce 
misalignment. To do so, click the View Options button, go to the Details tab, and select the 
Join Items checkbox to align the business supports with a common provider defined. 

• Understand where organizations are not supporting business processes. To do so, click the 
View Options button, go to the Details tab, and select the Show Direct Relationships 
checkbox.  

• If a matrix cell corresponding to a business process and organization is empty, this may be 
problematic if the organization has been defined to execute the business process. In this 
case, the executing organization does not IT support to the business process. 

• If a matrix cell is filled with business supports but the organization has not been defined 
as the executing organization for the business process, than the IT support is not 
effective. 

• Review the object states of business support providers, the business support, and the aspect 
values defined for the business support- To do so, click the View Options button, go to the 
Details tab, and select the Show Attributes checkbox. A small box with the information will 
be displayed on the right edge of the business supports in the matrix. 

• Analyze the potential gaps or redundancy of tactical business supports on operational aspects 
in order to focus specifically on tactical business supports that are relevant to certain 
operational aspects important to the enterprise. Click the View Options button, go to the 
Aspects tab, and set a checkmark next to each operational aspect that should be included in 
the business support map. All business supports not associated with the selected aspects will 
be hidden. 

• Additional reports also provide insight into the potential gaps or redundancy of tactical business 
supports on operational aspects such as brands, customer segments, markets, and sales channels. 
Operational aspects are relevant in the context of planning and analysis of tactical business 
supports and allow the tactical planner to understand the contribution that a business process or 
organization makes to the business. Understanding the contribution of individual business 
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supports to operational aspects sheds light on where future support is required in order to realize 
the enterprise's master plan.  

• The Business Process/Domain Aspect Analysis Page View for a master plan map provides an 
overview of the tactical business supports supporting the aspects relevant for a selected 
business process. The X-axis displays all aspects that are relevant for a selected business 
process. The matrix cells visualize the business supports contributing to the aspects, and the 
Y-axis displays all organizations that are supported by the business supports. 

• The Organization/Market Product Aspect Page View for a master plan map provides of the 
tactical business supports supporting the aspects relevant for a selected organization/market 
product. The X-axis displays all aspects that are relevant for a selected organization. The 
matrix cells visualize the business supports contributing to the aspects, and the Y-axis 
displays all business processes that are supported by the business supports. 

• Business Process Portfolio Page View and Organization Portfolio Page View respectively display 
the business processes or organizations relevant for the selected master plan map. Configured 
portfolios allow you to understand the relative performance of the business 
processes/organizations based on two or three independent dimensions of measurement. For 
example, a portfolio could be configured by your enterprise to display the estimated risk to 
business processes or the significance of the business processes to the business. 

• Various reports allow you to review the lifecycle information for the tactical business supports:  

• The Business Support Lifecycle Page View for a master plan map displays the lifecycles and 
lifecycles phases of the tactical business supports, operational business supports, and 
business support providers. You can edit the lifecycle information for the tactical or 
operational business supports displayed in the lifecycle chart. 

• The Business Support Lifecycle Report Page View allows you to aggregate the tactical 
business supports to either the applications or ICT objects that are defined to provide the 
support. 

• The Consistency Check Page View allows you to review and edit the alignment of start and 
end dates between tactical business supports and their business support providers 

• Various reports allow you to review and compare the tactical business support definition at a more 
granular level:  

• The Business Process/Domain-Based Schedule Report Page View allows you to understand 
the business supports defined for a single business process (or domain). Similarly, the 
Organization/Market Product-Based Schedule Report Page View allows you to understand the 
business supports defined for a single organization (or market product). 

• The Master Plan Comparison Report Page View allows you to understand which tactical 
business supports are unique to and shared by two specified business process or two specific 
organizations. 

• Business support maps may be difficult to manage if the business support map is large and 
complex. In this case, one or more map views can be created for a master plan map in order to limit 
the business processes, organizations, and business supports displayed in the business support 
map. This allows the master planner to focus on specific aspects of the business support or 
provide map views to other authorized users that address the specific needs of that particular user 
involved in the master planning effort. To create and analyze a map view defined for a master plan 
map:  
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• The Map View Page View for a master plan man allows you to create a map view and define the 
business processes and organizations to include in the map view. If color rules have been 
configured, you can select one or more color rules to cluster and color a specific set of objects 
in business support maps based on queries determined by your enterprise. For example, color 
rules could be configured to highlight operational costs of the ICT objects providing the 
business support. All objects found in the result set of the associated queries will be 
highlighted in the view. To do so, click the View Options button, go to the Details tab, and 
select the Use Color Map checkbox. The business supports will be highlight with color based 
on the configured color rules.  

 
A color rule is based on one or more Alfabet queries or native SQL queries that are 
configured to color a found set of objects. If the color rule functionality is activated, 
all activated color rules will be executed and the matrix cells colored accordingly. 
Color rules for map views could target applications, ICT objects, solution building 
blocks, providing organizations, tactical business supports, tactical business sup-
ports, and operational business supports. see the chapter Configuring Color Rules 
for Map Views and Diagram Views in the reference manual Configuring Evaluation 
and Reference Data in Alfabet. 

• The Business Support Map Page View for a map view displays the prescribed business support 
for the selected map view. You can do the following:  

• Modify the scope of the map view. You can hide individual business supports by selecting 
the business support and clicking Map View > Exclude Selected Object from View. You 
can also change the business processes and organizations displayed in the map view via 
the Edit button. 

• Aggregate business supports to either the ICT owning the business support's providing 
application or to the application version that an application variant providing the support 
is based on in order to check for alignment in the use of applications/ICT objects. To do so, 
click View Options and select Aggregate to Application or Aggregate to ICT Object. 

• Analyze where business supports are aligned across business processes/domains. You 
can display the business supports for which the same provider and aspects are defined as 
a single matrix object that is joined across the common business supports. In this way, 
you can assess where support is aligned vs. where new business supports are needed in 
order to reduce misalignment. To do so, click the View Options button, go to the Details 
tab, and select the option Join Items to align the business supports with a common 
provider defined. 

• Review the object states of business support providers, the business support, and the 
aspect values defined for the business support- To do so, click the View Options button, 
go to the Details tab, and select the option Show Attributes. A small box with the 
information will be displayed on the right edge of the business supports in the matrix. 

• Cluster and color a specific set of objects in business support maps based on queries 
determined by your enterprise. For example, color rules could be configured to highlight 
operational costs of the ICT objects providing the business support. All objects found in 
the result set of the associated queries will be highlighted in the view. To do so, click the 
View Options button, go to the Details tab, and select the option Use Color Map. The 
business supports will be highlighted with color based on the configured color rules. 

• Analyze the potential gaps or redundancy of tactical business supports on operational 
aspects in order to focus specifically on tactical business supports that are relevant to 
certain operational aspects important to the enterprise. Click the View Options button, go 
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to the Aspects tab, and set a checkmark next to each operational aspect that should be 
included in the business support map. All business supports not associated with the 
selected aspects will be hidden. 

• The Business Support Alignment Report Page View allows you to view and analyze the 
compliance of business supports. You can check for the compliance of operational business 
supports with tactical business supports or the compliance of tactical business supports with 
strategic business supports. Furthermore, you can assess whether the business supports are 
compliant with one another on dates that you specify. 

• The Business Process/Domain-Based Schedule Report Page View and Organization/Market 
Product-Based Schedule Report Page View allow you to review and compare the tactical 
business support definition at a more granular level: 

• The Business Process/Domain Aspect Analysis Page View and Organization/Market Product 
Aspect Page View provide overviews of the tactical business supports supporting the aspects 
relevant for a selected business process or organization. 

Prerequisites: Configuration Required for Master Planning 

The following configuration is necessary to work with master plans: 

• The following must be configured in the XML object ITMapDef available in the configuration tool 
Alfabet Expand. For more information about all configuration possibilities for business matrices, 
see the section Configuring Standard Business Support Matrices in the reference manual 
Configuring Alfabet with Alfabet Expand.  

• Default object classes to display on the axes. 

• Default order of the axis objects. 

• Permissible object classes for which business supports can be created. 

• Aspect groups and aspect values displayed on matrix objects. 

• Relevance values that allow users to filter information that lacks relevance for their current 
analysis of the IT landscape. 

• Ensure that the Review To-Be Architecture Functionality (ITM_Explorer) is available for the 
relevant user profile(s). 

• If color rules are to be implemented in map views, the color rules must be configured. This can be 

done in the Color Rules page view available either via the Master Plans  explorer icon or in the 
Configuration capability. For more information about the configuration of color rules, see the 
chapter Configuring Color Rules for Map Views and Diagram Views in the reference manual 
Configuring Evaluation and Reference Data in Alfabet. 

• If solution building blocks are implemented in master planning, the solution designer must ensure 
that the Target Architecture Planning workspace (ICTO_TargetArchitecture) is available in 
the custom object view of the relevant ICT object stereotype. The Target Architecture Planning 
workspace contains the views necessary to create and further define and analyze solution building 
blocks. 
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Appendix 1:  Working with Business Support Maps  

A business support map is the graphic visualization of the business support provided by specified objects in 
order to support the planning of the short-term, medium term, and long-term to-be architecture. The map 
is visualized as a matrix with an X-axis and a Y-axis. The X-axis of a standard business support map will dis-
play business processes and the Y-axis will display organizations that are supported. In some industry seg-
ments, it is more relevant to analyze the business support for market products than for organizations. If 
this is the case, market products may be configured for the Y-dimension of the business support. Further-
more, some enterprises may describe business supports to provide support to domains or business capabil-
ities of the business rather than business processes. If this is the case, domains may be configured for the 
X-dimension of the business support. 

Business support maps convey a wealth of information about the IT support planned in your enterprise. It is 
recommended that you familiarize yourself with the functionalities and view options available in business 
support maps before defining and analyzing your IT support. Whether you are planning the business sup-
port in the context of an IT strategy or master plan, the handling of business support matrices is very simi-
lar. The following describes the general handling of such matrices. 
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 FIGURE: Business support map for a master plan map 

For details about the functionalities relevant to the particular planning context, consult the context-sensi-
tive online Help for the page view that you are working with. 

 

The settings controlling the layout and behavior of business support matrices are configured by 
your solution designer in the XML object ITMapDef in the configuration tool Alfabet Expand. The 
solution designer may configure such aspects as the default object classes to display on the 
axes, the default order of the axis objects, the permissible object classes for which business 
supports can be created, the aspect groups and aspect values displayed on matrix objects, and 
relevance values that allow users to filter information that lacks relevance for their current anal-
ysis of the IT landscape. For more information about all configuration possibilities for business 
matrices, see the section Configuring Standard Business Support Matrices in the reference 
manual Configuring Alfabet with Alfabet Expand. 
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Depending on the specifications of the server hardware and operating system that Alfabet runs 
on, the size of business support maps may be limited. This is due to a limitation on bit maps that 
can be rendered on the server. In this case, large datasets may not export correctly. 

The following information is available: 

• Quick Start Tips for the Business Support Map 

• Setting Up the X- and Y-Axes of the Business Support Map 

• Implementing Business Process Model Filters in Business Support Maps 

• Communicating about Business Supports via the Notepad Functionality 

• Highlighting Matrix Objects With Color 

Quick Start Tips for the Business Support Map 

The following are general tips that will make it easier for you to start working with business support maps 
as well as handling large business support maps: 

• Unless your solution is configured differently, business processes will be displayed on the X-axis 
and organizations will be displayed on the Y-axis per default. In some cases, you can resort or 
add/remove objects on the X- and Y-axes. For more information, see the section Setting Up the X- 
and Y-Axes of the Business Support Map. 

• The axis definitions that you specify in the Business Support Map Page View for an IT strategy or 
master plan will be displayed for ALL business support matrices that you access in Alfabet and will 
also be displayed in the Business Support Map Report as well as all other relevant matrix views for 
the IT strategy, master plan, map view, etc. 

• A blueprint is an IT strategy or master plan that provides guidelines about which business support 
shall be defined. The blueprint may be embedded in the business support map. To display a 
blueprint, select the blueprint in the Blueprint field. For more information about creating a 
blueprint, see the section Methodology: Using Blueprints to Plan the To-Be and Target 
Architectures. 

• The functionalities available in the Business Support Map Page View are oftentimes dependent on 
the View Options settings. For example, the visibility of and ability to create operational and 
tactical business supports will depend on which options are defined via the View Options button 
in the toolbar. For example, to create an operational business support in a business support map, 
you must ensure that Create Operational Business Supports is specified in the View Options 
editor. 

• A business support map with many business processes and organizations can become very 
unwieldy. Please note that business support maps with more than 1000 business supports will 
result in a slight compromise in Alfabet performance. If the number of business supports to be 
displayed exceeds 1000, the user will be informed about the number of business supports 
displayed and the time required to retrieve and process this information. In order to make the 
business support map easier to use, a user can do any of the following:  

• Focus on a specific segment in the business support map using the zoom options in the 
toolbar at the bottom of the matrix. 
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• Focus on a specific segment in the business support map by shifting the focus of the map. To 
do so, select a matrix cell and:  

• Click the LEFT ARROW key on the keyboard to expose the leftmost column and shift the 
vertical focus of the map by one column to the left. 

• Click the RIGHT ARROW key on the keyboard to hide the leftmost column and shift the 
vertical focus of the map by one column to the right. 

• Click the UP ARROW key on the keyboard to expose the highest row and shift the 
horizontal focus of the map by one row down. 

• Click the DOWN ARROW key on the keyboard to hide the highest row and shift the 
horizontal focus of the map by one row up. 

• Collapse and hide the filter area to increase the space available for the business support map. 

To do so, click the Options  button in the filter area and select Hide Filter Panel. 

• Create a more condensed view that displays as little white space as possible across a row. To 
do so, click the View Options button in the toolbar to open the Business Support Map Report 
Options editor. In the Details tab, select the option Condensed Layout. The alignment of 
business supports will not be taken into account and the business supports will be ordered in 
the following sequence: strategic business supports, tactical business supports, and then 
operational business supports. 

• Create a map view to focus on only a section of the business support map with the information 
relevant for a particular user or issue. A map view can be created in the Map View Page View 
for a master plan map. 

• To navigate to the object profile of a business support, either select the object in the matrix and 
click Details > Navigate to Business Support or double-click the business support in the matrix. 

• To navigate to the object profile of a business process, organization, or the object providing the 
business support, select the relevant object on the X- or Y- axes or in the matrix and click Details > 
Navigate to Inventory Object. 

• Business supports can be defined in a number of ways:  

• To create a new business support, click the relevant menu ( Operational BSP, Strategic BSP, 
Tactical BSP ) in the toolbar and select the relevant object class that shall be the provider of 
the business support. The ability to create operational, strategic, or tactical business supports 
will depend on the settings defined via the View Options editor. 

• To move a business support, drag-and-drop the business support to the relevant cell in the 
matrix. 

• To copy a business support, click the CTRL key and drag-and-drop the business support to the 
relevant cell in the matrix. 

• To copy a business support or create new business supports based on a business support, 
select the business support in the matrix and click New > Business Support Assistant. 
Various options will be displayed that you can select. For example, this option allows you to 
create a tactical business support based on a strategic business support displayed in the 
matrix. 

• A Move/Copy menu is available in the toolbar that provides a cut, copy and paste option to 
create business supports in the matrix. To do so, select the business support, click Cut or 
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Copy in the Move/Copy menu, select the cell where you want to add the business support 
and click Paste in the Move/Copy menu. A selected business support may be pasted multiple 
times. 

• Some business supports in the matrix may display custom icons. These have been defined in the 
relevant object's editor.  

 
Depending on your solution configuration, you may see standard icons or custom icons 
configured for the objects displayed in the matrix cell. For more information about the 
configuration of custom icons for objects, see the section Configuring Class Settings for 
Object Classes and Object Class Stereotypes in the reference manual Configuring 
Alfabet with Alfabet Expand. 

• Per default, a matrix cell will first display the strategic business supports, secondly the tactical 
business supports, and thirdly the operational business supports. The business supports will thus 
be organized cell by cell and row by row, starting in the upper left top corner of the matrix. If the 
business supports have the same provider but differ, for example, in their operational aspects, 
they will NOT be displayed aligned on the horizontal axis. 

• A legend is available that explains the standard coloring as well as configured color rules of 

business supports. Click the Show Legend  symbol in the toolbar at the bottom of the view in 
order to open a legend that explains the content of the matrix. 

• Standard business support maps and business support map reports can be exported to a number 
of different file formats such as HTML + PNG, HTML + EMF, HTML + JPEG, HTML + BMP, SVG, PPT, 
and PDF. For more information about export options, see the section Exporting Data in the 
reference manual Getting Started with Alfabet. 

Setting Up the X- and Y-Axes of the Business Support Map  

When you first access a business support map, the view may be empty and the functionalities limited. You 
will first need to define the business processes that are displayed on the X-axis and the organizations that 
are displayed on the Y-axis. 

 
In some industry segments, it is more relevant to analyze the business support for market prod-
ucts than for organizations. If this is the case, market products may be configured for the Y-di-
mension of the business support. Furthermore, some enterprises may describe business sup-
ports to provide support to domains or business capabilities of the business rather than business 
processes. If this is the case, domains (business capabilities) may be configured for the X-dimen-
sion of the business support. The configuration of the X-dimension and Y-dimension of business 
supports will apply to operational business supports, solution business supports, strategic busi-
ness supports, and tactical business supports. 

For the sake of simplicity, the documentation will describe business processes on the X-dimen-
sion and organizations on the Y-dimension of business supports and business support maps. If 
your enterprise uses different object classes on the X- and Y-dimensions, please substitute the 
appropriate object class for the X- and or Y-dimension. 

A default configuration will determine which object classes can be displayed on the matrix axes in the Busi-
ness Support Map Page View. Unless your solution is configured differently, business processes are placed 
per default on the X-axis and organizations are on the Y-axis. 
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Please note that the axis definitions that you specify in the Business Support Map Page View for an IT 
strategy or master plan will be displayed for ALL business support matrices that you access in Alfabet and 
will also be displayed in the Business Support Map Report as well as all other relevant matrix views for the 
IT strategy, master plan, map view, etc. 

If strategic business supports have already been created for business process and organizations on the X- 
and Y-axes, these will be automatically added to the Business Support Map Page View. 

You can do the following to set up the X- and Y-axes of the business support map: 

• Add business processes and organizations to the X- and Y- axes. If objects are not available on 
both the X- and Y-axes of the business support map, the toolbar buttons to create business 
supports will be disabled. There are two ways to add objects to the axes of a business support 
map.  

• Add individual objects to the matrix axes. To do so, click New > Add Business Process or 
Add Organization. In the object selector, select the objects you want to add to the respective 
axis and click the Add button. When all relevant objects have been selected, click OK to add 
them to the matrix axis. 

• Add all objects assigned to the axes of another business support map. You can add the 
axes objects specified in the business support map for a selected IT strategy map or master 
plan map. To do so, click one of the following Select either IT Strategy Map or Master Plan 
Map in the Search For field in the object selector. Select the relevant IT strategy map or 
master plan map and click OK to add the axis objects to the business support map that you are 
currently working with.  

• Add X-Objects from Another Map to add all X-axis objects from a selected IT strategy 
map, or 

• Add Y-Objects from Another Map to add all Y-axis objects (either organizations or 
market products) to the Y-axis of the selected map, or 

• Add X- and Y-Objects from Another Map to add all objects defined for both axes to the 
respective axis of the selected map. 

• Remove unwanted business processes and organizations from the X- and Y-axes. Unwanted 

objects can be removed from the axis, as needed, by clicking the Detach  button. The matrix 
object as well as its business supports will remain in the Alfabet database. 

• Resequence the order of the business processes and organizations on the X- and Y-axes. To 
do so, click New > Axes Quick Editor. The X-Axis and Y-Axis fields list the objects in the 
sequence that they are currently displayed on the axes in the matrix. To change the sequence of 
objects on an axis, click an object in the relevant field and click the Up button to move it higher in 
the list or click the Down button to move it lower in the list. Repeat for all relevant axis objects in 
the X-Axis pane and in the Y-Axis pane.  

 

The sort order of the objects on the axes may be configured by your enterprise. If the 
sort order has not been configured by your enterprise, you will be able to re-order the 
objects on the axes via the Axes Quick Editor. If the sort order is configured, you will 
not be able to change the order of the axis objects. In this case, you cannot edit the se-
quence of axis objects but rather must work with the matrix based on your enterprise’s 
configuration. For more information, see the section Configuring Standard Business 
Support Matrices in the reference manual Configuring Alfabet with Alfabet Expand. 
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• Change the object classes on the X- and Y-axes. Although it may not be methodologically 
meaningful to do so, you can change the default object classes on the matrix axes at any time. 
Please note however that the axis definitions that you specify in the Business Support Map Page 
View will be displayed for ALL business support matrices that you access in Alfabet and will also be 
displayed in the Business Support Map Report as well as all other relevant matrix views for the 
master plan, map view, or IT strategy. To change the object class displayed on an axis, click the 
View Options button in the toolbar and select the relevant object class in the X-Axis field and Y-
Axis field. 

Implementing Business Process Model Filters in Business Support 
Maps 

Business process model filters may be specified in order to hide or substitute specific business processes 
with business process variants in the context of business support maps. If business process model filters 
have been defined, they will be available for selection in the Business Process Model Filters field in the 
Business Support Map Report Page View. 

The business process model filter options displayed in the Business Process Model Filters field are de-
fined in the Business Process Model Filters Page View available in the object profile of the relevant business 
process model. 

Communicating about Business Supports via the Notepad Func-
tionality 

You may create notes about a specific business support that is displayed in the business support map via a 
notepad functionality. The notepad capability facilitates free-form communication that is relevant for the 
business support map by allowing you to document additional information in the matrix cell representing a 
business support. For example, you could create a note that provides additional information about a busi-
ness support displayed in the matrix or you could create a note in a matrix cell for which no business sup-
port is defined in order to indicate that a particular business support is needed for the corresponding busi-
ness process and organization. The note is thus created directly in the matrix cell corresponding to the 
business process and organization that require the business support. 

Notes can be created in the Business Support Map Page View of an IT strategy map, master plan map, and 
map view. Any user who has Read permissions for a business support map may create and view notes even 
though that user may not have ReadWrite permissions for the business support map. If the notepad capa-
bility is enabled, users can also create notes in the Business Support Map Report. However, the notes will 
only be displayed in the Business Support Map Page View. 

 

The notepad capability will only be available if it is activated. To do so, click View Options, go to 
the Details tab, and select the Show Notepad checkbox and click OK. All existing notepad en-

tries will be displayed in their respective matrix cells and the  button to create a note will be 
displayed in the toolbar. To hide the notes, clear the Show Notepad option and click OK. 

An email notification may be sent to the authorized user responsible for the selected business 
support map informing him/her whenever a note is created for the business support map. The 
text displayed in the automatically-generated email notification is configured in the ITMap-
NoteCreated text template in the configuration tool Alfabet Expand. For more information, see 



 
 Appendix 1:  Working with Business Support Maps 

Alfabet 10.15  ©2022 Software AG. All rights reserved. Reference Manual 59 

the section Configuring Text Templates for Email Notifications in the reference manual Config-
uring Alfabet with Alfabet Expand. 

• To create a notepad entry, select the relevant matrix cell and click the  button to create the 
note. In the editor that opens, define the following as needed and click OK to save the note. 
Notepad For: Displays the name of the map as well as the business process and organization that 
the selected cell corresponds to. 

• Notes History: Displays a history of the exchange of notes. The syntax contains Date, Timestamp, 
User Name (name of the user writing a note), followed by the note text. 

• Note Info: Displays notepad information including the timestamp and name of the user who 
created the notes. 

• Note Text: Enter text for the note you want to create for the selected cell. 

• Notify IT Strategy/Master Plan Map Responsible: Select this checkbox if you want an automatic 
email sent to the authorized user who is responsible for the business support map. 

 

The most recent note will be displayed directly in the matrix cell. 

After a note in the business support map has been reviewed and any necessary action taken, you can re-
move the note from the cell by selecting it and clicking New > Clear Notepad Cell. The note will be removed 
from the matrix cell. 

Highlighting Matrix Objects With Color  

There are several methods to highlight matrix objects displayed in business support maps with color. You 
can either display the results found by configured color rules or you can assign colors to individual business 
supports. Assigned colors as well as the colors applied by color rules can be removed from the matrix and 
hidden. The following is possible: 

• Specify color rules to cluster and highlight a specific set ot objects in the business support map for 
a map view. Color rules are based on one or more queries that are configured to color a found set 
of objects. If the color rule functionality is activated for a map view, all activated color rules will be 
executed and the matrix cells will be colored accordingly. To implement color rules:  

• Color rules must first be configured in the Color Rules view available on the root node of the 
Master Plans Explorer. For more information about configuring color rules, see the chapter 
Configuring Color Rules for Map Views and Diagram Views in the reference manual 
Configuring Evaluation and Reference Data in Alfabet. 

• In the Map View editor, select a color rule group or individual color rules in the Color Rules tab. 

• Once a color rule is defined, it must be activated in order for the Alfabet query to be executed. 
The query should be re-activated periodically in order to update the query results and include 
changes made to the Alfabet database. The color rule may be manually activated in the Color 
Rules view or activated via a batch process. For more information about activation via a batch 
process, see the section Batch Evaluation of Color Rules with RescanColorRules.exe in the 
reference manual System Administration. 
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• Execute the color rules in the business support map. To do so, click View Options, go to the 
Details tab, and select the Use Color Map checkbox and click OK. All matrix objects 
associated with objects found by an Alfabet query specified for the color rule will be displayed 
with the specified color. The color rules will be automatically added to the legend of the views. 
If necessary, the color applied to individual tactical business supports or strategic business 
supports can be hidden.  

 
You must ensure that the settings for the matrix are meaningfully defined to display 
the results of the color rules in the view. For example, if the query associated with 
the color rule is specified to find tactical business supports, then you must ensure 
that the option Show Tactical Business Support is selected in the Objects tab in 
the Business Support Map Options editor. 

• A specific color can be assigned to a selected tactical business support or operational business 
supports displayed in in the Business Support Map Page View in order to highlight them in a way 
that is relevant to users working with the matrix. To implement a specific color definition for 
individual tactical business supports or operational business supports:  

• Define the color for the individual business supports in the Business Support Map Page View 
for a master plan map  

1) Click Analyze > Map Objects Report. 

2) In the Map Objects view, select the relevant business support(s) in the Tactical Business 
Support section or Operational Business Support section of the view. 

3) Click Action > Assign Color. 

4) In the Color Editor, enter a name for the color assignment in the Name field. Click the 
Color symbol, select a color in the Color editor and click OK. The color rule is applied to 
the selected objects in the Map Objects view as well as in the matrix views. 

• Execute the color definition in the business support map. To do so, click View Options, go to 
the Details tab, and select the Use Color Map checkbox and click OK. All business supports 
will be displayed with the specified color. 

• The color can be hidden by clicking Analyze > Map Objects Report, selecting the relevant 
business support and clicking Action > Clear Color. The color will be removed from the 
selected object in the Map Objects view as well as in the business support map. 
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